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Campaigns

MNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the Ul.

Campaigns are at the heart of Oracle Eloqua and marketing automation. Campaigns

enable you to create dynamic, personalized, and unique journeys for your contacts.

You can create two types of campaigns:

* Simple email campaigns allow you send a single email to a group of contacts. Choose your
segment, email, and when to send the message. A simple email campaign can also be used to

A/B test two emails.

* Multi-step campaigns allow you to create a highly customized marketing campaigns that can
intrigue contacts and adapt based on a contact's real-time activities. Using a simple drag and
drop Ul, quickly build campaigns that engage the right audience at the right time in your

customer's journey.

Of course you'll want to monitor your campaign's performance. Oracle Eloqua allows you

to easily access reports and performance metrics right from the campaign canvas.

Learn more by watching these videos!


EloquaRedwoodExperience.htm
https://www.youtube.com/playlist?list=PLw7GyH-Hj8cPSuqKwgp2gf9lXwXrpRH0C

Creating multi-step campaigns

A multi-step campaign is a highly customizable marketing tool. Simply add the elements
of your campaign to the campaign canvas and then connect them to create your

campaign flow.

Learn more by watching the video.

CTip: Looking to create a one-time batch email? Consider using a simple email

campaign instead. This is an ideal way to send a single email to a group of contacts

or conduct A/B testing on emails.

Before you begin:

* Plan out your campaign. Document your campaign goals, target audience, key messages, and
identify the appropriate channels to reach your audience. If you're not sure where to start, have

a look at the Best Practices templates provided within Oracle Eloqua.

* Create all the assets (emails, forms, landing pages) required for your campaign. If you need to
add something after activating the campaign, that is OK. Just deactivate the campaign and
make the changes you need. Keep in mind this information about leaving a campaign

deactivated for more than 3 months.

* If you want to be able to report on all of the form and landing page activity resulting from your
campaign, be sure to add them to the campaign canvas. This allows you to attribute form

submits and page visits back to the campaign. Find out more about campaign reporting.

* Before activating your campaign, plan to test it first. This will catch typos, broken links, and

ensure you're sending the right emails in your campaign flow.


https://www.youtube.com/embed/videoseries?list=PLw7GyH-Hj8cMT_qDImDPqZiTDtPN4C6Gj
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=TemplateChoosers

To create a multi-step campaign:

1. Navigate to Orchestration , then click Campaigns.

2. Create a new multi-step campaign.

« Inthe classic Ul, click Create a multi-step campaign.

¢ Inthe Redwood experience, click Create > Multi-Step Campaign > Create.

3. Select a template or use the blank campaign. The campaign canvas opens.

= ORACLE towua A - - B B M- @ o @ -
@ BRAFT (&3 Untitled Campaign Save Verity
@ Filew Actions~ Options ~
@ b Campaign Steps @ =
Segm: Members

@ Drag-and-drop elements here to start building

O Campaign name and state
® Menu bar

©) Campaign elements

® Campaign canvas

®© Campaign settings

4. Atthe top of the canvas, double-click Untitled Campaign and type in a name for your

campaign.



DRAFT Untitled Campaign

File = Actions = Options v\

5. Configure the settings for your campaign.

a. Click Options, then click Campaign Settings.

b. Add a description of the campaign and set when the campaign will start and end.

i Description

Campaign start date

(@ Immediately

O

(UTC-05:00) Eastern Time (LIS & Canada)
Campaign end date
() 1 month
() 2 months
() & months

(@ 1year

() Custom Date

.

c. Click Advanced and configure additional details:
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4 Advanced
Contact campaign re-entry

D Allow contacts to enter the campaign mare than once.

CRM
Sync with CRM

CRM Campaign ID

* To allow a contact to enter the campaign more than once, click the Allow contacts to enter the campaign
more than once option. If you select this option, after a contact enters the campaign, the contact can enter
the campaign again. For example, if you want to allow contacts to flow through a different path of your
campaign and receive a different email. Or if you have an ongoing campaign where assets regularly change

each time the contact flows through the campaign.

* To sync the campaign with your CRM, click the Sync with CRM option. Leave the CRM Campaign ID field
blank. It will populate after Oracle Eloqua syncs with your CRM.

d. Click X to close the settings.

6. Configure any additional campaign information used by your organization by clicking Options >
Campaign Fields. Use the Campaign Fields dialog to provide further information about the
campaign that can also be used for reporting purposes. For example, budget information, any
custom campaign fields required by your organization, and so on. You can also add an end date

notification on the Notifications tab.

7. Add elements to the campaign canvas by double-clicking the element in the Campaign Steps
pane. By default, popular elements are shown. To view all the available elements, click the

Campaign Steps heading. You can mark your own favorite elements by clicking the star icon.



A Campaign Steps e—

Q, Search
Audience
E Segment Members b
# OSC Feeder *
Assets
- Email w
ﬂ Form (reporting only) w
E Landing Page (reporting only) w
Decisions
n Clicked Email? w
m Compare Contact Fields b
E Compare Custom Object Fields b
E Shared List Member? w
n Shared Filter Member? w
E Opened Email? b
E Sent Email? w
E Submitted Form? w
m Visited Website? w
E Compare Date w
Actions
W Move to Campaign W
4l Add to Campaign w
®

Tip: You can copy and paste groups of steps by highlighting them with your cursor and

using your default keyboard shortcuts (for example, Ctrl+C to copy and Ctrl+V to paste).

8. Configure each element by double-clicking the element. See the following topics for more

information on campaign canvas elements:

©2025 Oracle Corporation. All rights reserved 10 of 167



* Configuring audience elements
* Configuring asset elements

* Configuring decision elements
* Configuring action elements

9. Connect the steps on the canvas to form the campaign flow. To do this, click the circle at the

bottom of the element and drag the line that forms to the circle at the top the next element.

@'ip: Add notes to your campaign to help you remember where you left off while working

and alert colleagues as to the purpose of your campaign. Learn about adding notes.

10. Click Save.

®S\ote: Draft errors appear ORAFT until you have completely configured the

campaign. Click the error indicator to view a list of all validation errors. You must resolve

all draft errors before you can activate the campaign.

After you finish configuring the campaign and resolve all draft errors, you can activate the

campaign.



Creating simple email campaigns

MNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the Ul.

If you want to send a single email to a group of contacts, you can create a simple email
campaign. The simple email campaign lets you send an email to a segment in a few steps

and without having to touch the campaign canvas.

After you send the email, you can immediately start to see the email's performance and

metrics such as email opens, click-throughs, and conversions.

CTip: Enroll in our free Udemy course to learn about the basics of marketing

automation and creating a simple email campaign in Oracle Eloqua.

Learn more by watching the video!

®MNote: The approvals workflow is not available for simple email and A/B test

campaigns.

To create a simple email campaign:


EloquaRedwoodExperience.htm
https://www.udemy.com/course/creating-a-simple-email-campaign-in-oracle-eloqua
https://www.youtube.com/playlist?list=PLw7GyH-Hj8cNuWW5uj-l3aP9PrZlVsk3L

Navigate to Orchestration , then click Campaigns.

Create a new simple campaign.

¢ Inthe classic Ul, click Create a Simple Email Campaign.

¢ In the Redwood experience, click Create > Simple Email Campaign > Create.

First, give your campaign a name. In the classic Ul, be sure that you select Simple as the

campaign type.

Specify the segment to use for this campaign. You can optionally create a new one or upload a

contact list instead.

@'ip: As you configure the campaign, Oracle Eloqua validates your configuration.

1
In the classic Ul, click the caution icon = to review the error.

* Inthe Redwood experience, click the step in the table of contents that appears with an error

indicator -

Next, specify the email to use in the campaign. You can choose an existing email, create a new

one or upload an external file.

Next, specify when to launch the campaign.

» To start the campaign immediately after you active it, click Send now.

« To start the campaign on a specific date and time, click Schedule for a later time in the classic Ul or

Send later in the Redwood experience. You can then specify the date and time to start the campaign.

Click Advanced sending options to configure other email options.

* Use a Signature: Allows you to configure the email signature. You can choose to Send using a
dynamic signature rule or Send on behalf of a single user. If the campaign's email includes a layout,

the signature will be dynamically populated based on the sender.



The sender's user account does not need to be active nor does the person associated to the user
account need to have access to Oracle Eloqua. The user account and associated signature fields will
be used to populate the email sender and sender information like a signature where applicable. Learn

more.

¢ Include List Unsubscribe header: Add an unsubscribe header to your email.

* Break send into smaller batches: Break up sending emails into smaller batches. The period you use
depends on the size of the segment. If you are not sure what period to set, start with about 1000

emails per hour. So, for a segment of 3000, sending the email over 3 hours will send 1000 per hour.

¢ Only send during certain days and hours: Allows you to configure when to send the email. For

example, use this option to send only at off-peak hours or at an optimal time that you've determined.

* Enable send time optimization: Allows you to configure the email to send based on the contact's
individual optimal send time. Available with the Eloqua Advanced Intelligence Cloud Service add-on

only. Learn more.

+ Allow emails to be re-sent to past recipients: Allow this email to be re-sent to past recipients.
Typically, you do not want to select this option so that you don't send duplicate emails to your

contacts.

* Send email to master exclude members: Allow this email to be sent to contacts on the master
exclude list. This ensures that members on this list do not miss out on critical non-marketing emails,

such as product information.

* Send email to unsubscribed members: Allow this email to be sent to unsubscribed contacts. This
ensures that unsubscribed members do not miss out on critical non-marketing emails, such as

product information.

8. To configure campaign fields:

»
In the classic Ul, click Actions , then click Settings.

=
In the Redwood experience, on the Review and submit step, click = Properties.

ooo

Here you can set campaign fields like product, country, and so on required by your company,

and change the CRM sync or closed-loop reporting settings.

9. Click Save to save the campaign.


CreatingIndividualUsers.htm#Add
CreatingIndividualUsers.htm#Add
STO_SendTimeOptimizationOverview.htm

10. Click Activate Campaign to activate the campaign according to its schedule.

®ote: You must resolve all errors before you can active the campaign.

Oracle Eloqua sends the email or sends it according to the schedule you set. The campaign's
status changes to Active or Scheduled. You cannot change the campaign once it is Active or

Scheduled. Find out more about changing an active or scheduled campaign.

Monitoring campaign performance

After the campaign is Active, you can see a real-time view of the email's performance.

Campaign reporting and metrics.

* To view the latest information, you can refresh the report. In the Redwood Ul, this option is

available in the Actions menu.

* To view details about the contacts included or excluded from the email send, use the

participants report or the Email Entry and Email Exit operational reports.

* Real-time reporting is available for up to 3 months after the campaign was activated. Use
Insight reporting for historical reporting. All activity for the email campaign is tracked for 12

months after the campaign started.

Changing an active simple email campaign

A simple campaign runs for 3 months from the start date and collects activities for 1 year.

If you need to make changes to the campaign like setting campaign fields or changing the



campaign name, you must first deactivate the campaign.

When you reactivate the campaign, Oracle Eloqua continues sending the email to those

contacts in the segment that had not already been sent the email.

If you do not reactivate the campaign within 3 months, Oracle Eloqua closes the
campaign and removes any contacts from the campaign that were not sent the email. The
change is associated to the user who last modified the campaign. For more information,

you can check out the retention policy.



A/B testing campaigns

A/B testing is one of the easiest ways to increase conversion rates and learn more about
your audience. In an A/B test, you are testing a control version of an email (A) against a
different version (B) to measure which one is most successful. Depending on your goals,
an A/B test can help you determine such things as the effectiveness of subject lines,

content, and calls to action.

CTip: To use a multi-step campaign, you can use the Audience Split step to split

contacts down different paths by percentages.

Before you start A/B testing

* Identify the objective of the A/B test. Typically, you want to identify one element of an email that
you want to test. For example, you could focus on content elements like subject lines,
headlines, or calls to action, or design elements like color choice, button design, and so on. This

blog post can help identify the features you might want to test.

* Identify the metrics you'll use to measure the effectiveness of your A/B test. When setting up the
test, Oracle Eloqua lets you identify one metric that determines the winning email. The winning
metric could be one of the following: total opens, unique opens, total clicks, unique clicks, total
conversion, or click-through rate. Choose the metric that aligns with your goals for the test. If
you're looking for high engagement, you might want to focus on opens or clicks. If you're
focused on goal completion, the total conversion metric might be more appropriate. For more

information on how these metrics are calculated, see Campaign reporting and metrics.

* Send the A/B test emails to enough contacts that you're confident the results of the test are
trustworthy. The size of your segment, the content of the email, and any time constraints should

help you determine an appropriate test group size.



* Plan to capture the results of the A/B test and share them. You'll want others to benefit from any

new discoveries.

Creating an A/B testing campaign

To create an A/B testing campaign:

1. Navigate to Orchestration , then click Campaigns.

2. Create a new campaign.

¢ Inthe classic Ul, click Create a Simple Email Campaign and then click A/B Test in the wizard.

¢ In the Redwood experience, click Create > Simple Email Campaign > Create.

3. First, give your campaign a name. In the classic Ul, be sure that you select A/B Test as the

campaign type.

4. Specify the segment to use for this campaign. You can optionally create a new one or upload a
contact list instead. Later you will indicate what percentage of the segment to include in the

testing.

@'ip: As you configure the campaign, Oracle Eloqua validates your configuration.
1

L] [ = '] .
In the classic Ul, click the caution icon = to review the error.

* Inthe Redwood experience, click the step in the table of contents that appears with an error

indicator -

5. Next, specify the emails to use in the test.



6. Specify the size of your test audience and the metric (such as total opens or total clicks) that

determines the winning email.

To configure the percentage of the segment that you want to participate in the A/B test, drag the slider.
For example, when you set it to 50%, this means that 50% of the segment will participate. 25% of the

segment will receive the control email (A) and 25% will receive the test email (B).
To select the metric to determine which email performed the best, select the Winning Metric.

Configure how long you want the A/B testing campaign to run. You can set the test to run for hours,

days, weeks, or months or set an end date.

To automatically send the winning email to the remaining contacts when the A/B test ends, select
Automatically send the winning version. We'll only send out the winner if a winner is declared based
on the winning metric. Otherwise, you'll get a notification if the test was inconclusive. In the event of a

tie, Oracle Eloqua sends an email and you must manually select a winner.

7. Next, specify when to launch the campaign.

To start the campaign immediately after you active it, click Send now.

To start the campaign on a specific date and time, click Schedule for a later time in the classic Ul or

Send later in the Redwood experience. You can then specify the date and time to start the campaign.

8. Click Advanced sending options to configure other email options.

« Use a Signature: Allows you to configure the email signature. You can choose to Send using a

dynamic signature rule or Send on behalf of a single user. If the campaign's email includes a layout,

the signature will be dynamically populated based on the sender.

The sender's user account does not need to be active nor does the person associated to the user
account need to have access to Oracle Eloqua. The user account and associated signature fields will
be used to populate the email sender and sender information like a signature where applicable. Learn

more.

Include List Unsubscribe header: Add an unsubscribe header to your email.

Break send into smaller batches: Break up sending emails into smaller batches. The period you use
depends on the size of the segment. If you are not sure what period to set, start with about 1000

emails per hour. So, for a segment of 3000, sending the email over 3 hours will send 1000 per hour.

Only send during certain days and hours: Allows you to configure when to send the email. For

example, use this option to send only at off-peak hours or at an optimal time that you've determined.


CreatingIndividualUsers.htm#Add
CreatingIndividualUsers.htm#Add

¢ Enable send time optimization: Allows you to configure the email to send based on the contact's
individual optimal send time. Available with the Eloqua Advanced Intelligence Cloud Service add-on

only. Learn more.

« Allow emails to be re-sent to past recipients: Allow this email to be re-sent to past recipients.
Typically, you do not want to select this option so that you don't send duplicate emails to your

contacts.

* Send email to master exclude members: Allow this email to be sent to contacts on the master
exclude list. This ensures that members on this list do not miss out on critical non-marketing emails,

such as product information.

* Send email to unsubscribed members: Allow this email to be sent to unsubscribed contacts. This
ensures that unsubscribed members do not miss out on critical non-marketing emails, such as

product information.

9. To configure campaign fields:

10.

11.

»
* Inthe classic Ul, click Actions , then click Settings.

In the Redwood experience, on the Review and submit step, click Properties.

Here you can set campaign fields like product, country, and so on required by your company,

and change the CRM sync or closed-loop reporting settings.

Click Save to save the campaign.

Click Activate Campaign to activate the campaign according to its schedule.

®lote: You must resolve all errors before you can active the campaign.

Oracle Eloqua sends the email or sends it according to the schedule you set. The campaign's
status changes to Active or Scheduled. You cannot change the campaign once it is Active or

Scheduled. Find out more about changing an active or scheduled campaign.


STO_SendTimeOptimizationOverview.htm

Monitoring campaign performance

After the campaign is Active, you can see a real-time view of the email's performance. To
view the latest information, click Refresh. To view which contacts were included or

excluded from the emails, use the View Participants report.

After the A/B test campaign ends, you can review the overall performance of the winning
email. If you automatically sent the winning email to the remaining segment, the overall
performance will be updated with the details from the winning email. About the results of

an A/B test.

Changing an active A/B test

An Active testing campaign cannot be deactivated. If you want to stop sending the test
emails and end the test, you must cancel the campaign. In the Redwood experience, click

End Campaign on the Campaign Details tab.

About the results of an A/B test

®MNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the Ul.

After you activate an A/B testing campaign, you can keep an eye on the results. Oracle
Eloqua continues to track all activity for the testing campaign for 12 months after the

campaign started.


EloquaRedwoodExperience.htm

Real-time summary of the campaign

While the A/B testing campaign is running and before a winner has been chosen, you can
view the results of the test in real-time. You can view how many emails we sent or
excluded, a count of contacts included in the testing, and real-time email performance

metrics.

© Total emails sent or excluded
® Total contacts included in the test
®© Email performance metrics

O] Link to view contacts included or excluded from the send

Viewing the contacts included or excluded from the
campaign

To view the details of the contacts sent an email in the A/B testing campaign (or those
that excluded from the original segment), use the View Participantlinks. This provides
visibility into which contacts received the emails, and which failed to receive them, either

due to unsubscribes, bouncebacks, or other deliverability issues.

Winning metrics and campaign performance

After a winner has been chosen, you can view the performance of the winning email. Find

out more about reporting metrics.



CTip: You can view the metrics from the original test in the Email testing details

section.

Choosing the winning email of an A/B testing campaign

If you did not choose to automatically send the wining email, you can manually choose

the winner. This will allow you to view a final report about the performance of the winning

email.

®Note: You can manually select the winning email at any time - even when the
campaign is still running. After manually selecting a winner, Oracle Eloqua sends

out the winning email to the remaining segment if the campaign was configured to

do so.

To select the winning email:

1. Navigate to Orchestration , then click Campaigns.

2. Open the A/B testing campaign.



3. Choose the winner:

 Inthe classic Ul, click Select Winner. Choose the winning email and then click End Test.

Select Winner to End Test Now View | Total Opens [+

AJB Test has been completed, please select a winner bhelow

A-Test-02242017

Subject
Sample Atest
From

Mew Client

View Participants 0 TOTAL OPENS

B-Test-02242017
B Subject
Sample B test

From

MNew Client
View Participants 0 TOTAL OPENS

Select Winner This will end the testimmediately.

* Inthe Redwood Ul, choose the winning email and then choose Select Winner.

Select Winner
® Email A (O Email B

Select Winner




Setting up campaign notifications

The following campaign notifications are available in Oracle Eloqua:

* Wait step notifications

* Campaign end date notifications

Notifying users when a contact enters a wait step

You can send notifications to the Marketing Operations Center when a contact enters a
wait step in a multi-step campaign. All users with interface access to the MOC will be able
to see the notifications. This is useful when using wait steps as an "error step" to

determine when contacts are not following the desired path through a campaign.

BExample: You have a wait step set after the No path of a decision step. This wait
step is designated as an "error step"” to determine when a contact slips through the
decision filter. Your team is then to determine the cause of the error and update the
contact accordingly. Through the wait step notifications, your team can check the
Marketing Operations Center to determine when a contact enters one of these error

steps across all campaigns with wait step notifications.

To set up a wait step notification:

1. Navigate to Orchestration , then click Campaigns.

2. Open an existing multi-step campaign or create a new one.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=MOC
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=InterfaceAccess
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=MOC

3. Right-click the wait step for which you want to receive notifications.

4. Select the Send a notification check box.

Step name:

Wait

Choose how long contacts should wait in this step:

{iﬁl Wait for a set amount of time:

1 Weekis) =

v

() Wait until a specific date and time:

Send a notification to the notification center when a contact
enters the step

5. Click Save.

To view wait step notifications:

1. Navigate to Home ﬁ then click Operation Center.

2. The notifications will be arranged by time received, and display the campaign and step name.

®lote: The campaign will be hyperlinked so you can quickly navigate to the relevant wait

step.



Notifying users about an ending campaign

You can notify users when a multi-step campaign is coming to a close. Maybe you have
an ongoing nurture campaign for prospects and you're going to extend the end date
before the campaign concludes. You can have Oracle Eloqua send an email notification

to selected users when the campaign is approaching its end date.

To set a notification about an ending campaign:

1. Navigate to Orchestration , then click Campaigns.

2. Open an existing multi-step campaign.

MNote: If you create a new campaign, the Notifications tab in the Campaign

Fields window only appears after you save your campaign.



3. Click Options, then Notifications.

Campaign Fields

General Financials Custom Fields | Notifications

o Add users to this list to receive a notification before the campaign's end
date. Ifthe campaign's end date is sooner than the campaign nofification
duration, we will send out an email immediately to all users in the
notification list.

Send campaign completion notification:

2 business days before -

4. Search for a user by typing in the add a userfield, then select the user from the list. You can

have a maximum of 10 users in a campaign notification

5. Select when you want to notify users of the campaign ending from the Send campaign

completion notification drop-down list.



Sote: If the campaign end date is sooner than the selected date, an email will be sent to

the selected users immediately.

6. Click Done and then save your campaign.



Configuring campaign details and financials

As a customer administrator you can setup default campaign details and financial

information. These settings are usually configured when campaigns are initially

implemented in the application, so that all subsequent campaigns use the same

baselines and are directly comparable. These defaults are applied to all campaigns, but

they can be adjusted at any time.

To configure campaign details and financials:

1. Navigate to Orchestration == > Tools, then click Campaign Settings. The Campaign Settings

2.

window opens.

Campaign Settings
Campaign Details & Financials
Fiscal Year Begins In  January -

Default Currency  US Dollar (USD) -

Save

Configure the Campaign Details & Financials section:
* Fiscal Year Begins In: Set the month in which fiscal reporting for your company begins for a new

financial year. This allows you to align marketing reports with financial reports.

« Default Currency: Set the currency that will be used by default for financial calculations.

Rjote: Default currency maps to the field called Base Currency in the financial set-up details.



3. Click Save when you are finished.

Default campaign details and financials are set. You can change them at any time.



Activating multi-step campaigns

You can activate a multi-step campaign now or schedule it to start later. To activate the

campaign, you must specify how long you want the campaign to run.
After the campaign ends, the following occurs:

* Oracle Eloqua deactivates the campaign and the status changes to COMPLETED.

* The campaign becomes read-only and you cannot reactivate the campaign, add contacts to it,

or modify any settings. If you want to reuse the campaign, you can copy it.

* Oracle Eloqua removes all contacts who were members of a campaign element and the

contacts exit the campaign.

* Oracle Eloqua continues to track all campaign activity for 12 months after the campaign end
date. If a contact opens an email, submits a form, or performs other campaign-related activities,

Oracle Eloqua captures those actions and you can report on them.

LY

Note: You must have permissions to activate a campaign. If you see an Approvals
button on the campaign canvas, the campaign must go through an approvals
process before activation. See campaign activation security for more information

about activation permissions.

Before you begin:

oFI'

. DRA . . -
Resolve any draft errors . You can view the errors by clicking the error indicator or by

clicking Verify. All errors must be resolved before you can activate the campaign.



* Ensure that any Oracle Eloqua AppCloud apps on the campaign canvas are fully configured.

* After you activate the campaign, you cannot make changes to it. You will have to deactivate the

campaign to make changes.

* Test your campaign and the campaign assets thoroughly. For example, send test emails,

preview landing pages, and submit forms associated with the campaign.

®MNote: You cannot activate a campaign if the campaign reporting start date is after

the activation date. See this knowledge base article to find out more about

campaign dates.

To activate a campaign:

1. Navigate to Orchestration , then click Campaigns.

2. Open the campaign you want to activate.

3. Click Activate. The Activate Campaign window opens.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps
https://support.oracle.com/epmos/faces/DocContentDisplay?id=1612552.1

Activate Campaign
{ Campaign Activation Start Time
]
(@) Start Now

() Start Later:

0 Campaign Activation End Time

TI272017 L

Campaign Reporting will associate with this campaign from 7/27/2016 to 7/27/2018
(12 months after the completion date}.

®ote: You will also see Campaign Activation User options if you are an administrator.

4. Configure the activation:

¢ To start the campaign immediately, click Start Now.

¢ To choose a date for the campaign to start, click Start Later and schedule the start date and time. The

default time zone is based on the server, not the time zone from your local machine.

¢ Specify the duration of the campaign using the Campaign Activation End Time field. The end time
will always be at midnight on the date selected. The default end date is for 3 months. Only set
durations up to what is necessary and not far beyond. This is to prevent the canvas from continually
triggering the segments to run unnecessarily. After the end date, the campaign will become read-only
and Oracle Eloqua continues to track all campaign activity for 12 months after the campaign end date.

You can also set up an end date notification for your campaign.

5. Click Activate or Schedule to save your changes.

Oracle Eloqua activates the campaign according to the schedule you set and the campaign's

status changes to Active or Scheduled.

After you finish:



After a campaign is Active, you can track the flow of contacts through your campaign

elements:

* To view where contacts are in the campaign, click Refresh. A number appears beside elements
telling you how many contacts are now in that element. If there is a segment element, a number

next to the element indicates the number of contacts who've entered the element so far.

* To view more information about the counts, double-click the number. See Tracking segment

members in campaigns or programs for more information.

/ O] —
- Segment Members

Wait ACME Business Units

0.01 Hours
007 Hours 1 2352 contacts entered -«

About deactivating campaigns and Oracle Eloqua's
retention policy

When you deactivate a campaign, Oracle Eloqua does the following:

* Changes the campaign's state to DRAFT. The change is associated to the user who last

modified the campaign.
* Stops moving campaign members through the campaign.
* Holds campaign members in their current step until you reactivate the campaign.
A deactivated campaign can remain in this DRAFT state and hold campaign members for

3 months. After that, Oracle Eloqua performs the following clean-up tasks on those

campaign members Oracle Eloqua was holding:

* Removes the campaign members that were being held

* Removes the campaign entry record for those removed members and they no longer appear in

the Campaign Entry report


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=TrackingSegmentsCanvas
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=TrackingSegmentsCanvas

* |dentifies the removed campaign members in the Campaign Exit report with the exit type

Removed due to Retention Policy



Moving contacts through a program or
campaign

In most cases, once you set up your program or multi-step campaign, you will let contacts
flow automatically through the workflow. However, you can manually move contacts
through a decision or action step or remove them from the campaign or program all

together.

To move contacts through or remove contacts from a step:

1. Inthe campaign canvas or program canvas, double-click the number of contacts on a decision

or action step.

T 175,000 I
Wait

0.01 Hours

The step members report opens.

View Campaign Step Members

Campaign Name: Example Campaign Displaying 200 of 5,000 total member(s) Q
Step Name: Compare Contact Fields

ctview  General Contact Fields =
[T select All Contacts contactview

First Name Last Name Title Business Phone Address 1 City Industry Status Email Address Entr
Awaiting action

Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awal tion

Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action

Awaiting action



2. Choose an option:
¢ To move a contact to another step, select the contacts in the report, then click Move. Choose the new

step and click Move Members.

¢ To remove a contact from the campaign or program, select the contacts, then click Remove.

Removing contacts from a simple campaign
You can remove contacts from a simple campaign if the contact was excluded from the
email send.

1. Open the simple campaign. The campaign must be active or completed.

2. Open the View participants report:

* Inthe classic Ul, click View Participants link under the segment name.

* Inthe Redwood experience, click Actions > View participants.

3. Onthe Excluded tab, select the contacts you want to remove and click Remove. If you want to

remove all the excluded contacts, click Remove All.



Adding notes to campaigns and programs

Notes can help you remember where you left off while working and alert colleagues as to
the purpose of your campaign or program. You can create general campaign and

program notes, as well as notes for a single step.

View and create notes Sort notes by
using the Notes tah == Notes date or author x

Sort By Date Asc -

Segment Members
EMEA Q1/16 Breakfast Series
| .

Marzena Stencel TM62018

EMEA contacts will receive an invitation to a breakfast event .

Linked Step{s):
[ote applied to Segment
INVITE EMAIL Segment ru1emners<[ Members step ]
EMEA - Q317 Breakfast Seri...

Segment Step

# Marzena Stencel TMB2018 &

This campaign is a follow-up to the EMEA webinar
"M submitted Form? i i
EMEA - Q1H6 Breakfzst Seri... Note applied to S‘I‘thmt:dlt Dtr
A entire campaign 2lele the note

To add a note to a campaign or program:

1. Open an existing multi-step campaign or program.

2. Select your note destination.

* Toadd a note to the entire campaign or program, click Notes , then click Add Note.

* Toadd a note to a singe step, right-click the step to which you want to add a note, then click Add

Note.
3. Type your note content.

4. Click Add Note to save.

Once your note is saved, click * to edit or delete it. Notes can be edited or deleted by any

user who has edit permission to the asset.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ProgramCanvas

Copying campaigns

You can make a copy of a simple or multi-step campaign. You can then change the
campaign for your needs. When you copy the campaign, Oracle Eloqua copies almost all
the campaign's configuration and settings. After you make a copy, you'll want to open the

copy and make sure you configure it for your current needs.

@Tip: If you are copying a multi-step campaign, you might consider creating a
campaign template instead. Templates are an easy way to speed up your campaign

creation process, reduce errors, and ensure consistency.

To copy a campaign:

1. Navigate to Orchestration , then click Campaigns.

2. Search for the campaign you want to copy.

3. Copy the campaign:

* Inthe classic Ul, right-click the campaign in the search results and select Copy.

In the Redwood experience, click Actions > Copy.

4. The copied campaign appears with the word Copy appended to the name. The copied

campaign has a DRAFT status.



5. Open the copy and make the changes you need before activating the campaign.

@'ip: Make sure you rename the campaign so that it reflects it's current purpose.



Campaign templates

You can create custom multi-step campaign templates. Using templates can help speed
up your campaign creation process and reduce errors. Templates can also help your
organization maintain consistency, which is important when you have many Oracle

Eloqua users.

In this topic, you'll learn about:

* Creating templates
* Finding and using a template

* Managing campaign template

Creating templates

Before you begin:

* Consider the types of templates your organization needs. If you are consistently creating the

same types of campaigns, you should consider making those campaigns into templates.

* Make sure that your template follows the best practices used by your organization such as

campaign timing or naming conventions.

RNote: After you save a template, you cannot change it. To change the template,
create a new campaign using the template you want to change. Make your changes
and then save the campaign as a new template. You can then delete the old

template to avoid confusion.



To create a template:

1. Navigate to Orchestration B, then click Campaigns.

2. Create a new multi-step campaign or open an existing one that you want to use as the basis for

your template.

3. Set up the campaign completely including the campaign settings and campaign fields. Give the
campaign steps descriptive names that will help users understand the elements of the

campaign.

Gmportant: Before you save the template, make sure you have completely set up the

template. Remember, you cannot change a template after you save it.

4. Select File > Save as Template.

Save as Template

Mame:

Event template

Description:

Use this template to create an event campaign which
includes the initial invitation, reminders, and post
event details.

Change Icon... Texi to Display for Link:
Find out more about the template

URL for Link:

hitp//docs.oracle.com
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5. Complete the information about the template and click Save. This information appears in the

Template Chooserwindow when users choose the template.
¢ Tolink to a web page that provides more information about the template, complete the Text to
Display for Link and URL for the Link fields. When users select the template, they can follow the link

to find out more.

Finding and using a template

After you create a template, users can use it to help them create a new campaign.

RNote: Templates do not get included in the regular campaign search. They're only

displayed and searchable in the Template Chooser.

To find and use a campaign template:

1. Navigate to Orchestration , then click Campaigns.

2. Create a new multi-step campaign.

* Inthe classic Ul, click Create a multi-step campaign.

¢ Inthe Redwood experience, click Create > Multi-Step Campaign > Create.

3. Select the template to continue with the campaign creation.

Managing campaign template

After creating a template, you can change it, rename or delete the template. Any changes

you make will impact the next campaign created with the template.



®MNote: You can only change the template using the Redwood experience. In the

classic Ul, you can rename, delete, and copy templates using the template chooser.

To manage a campaign template:

1. Turn on the Redwood experience.
o Navigate to Orchestration, then click Campaigns.

3. Click Templates from the page selector and find your template.

4. Open the template to make your changes. To rename or delete the template, click the Actions

menu and choose the option.


EloquaRedwoodExperience.htm

Deleting campaigns

Before you begin:

* You cannot delete Active or Scheduled campaigns. If you want to delete a campaign in one of

these states, deactivate the campaign first.

* You must resolve all dependencies before you can delete a campaign. In the Redwood
experience, you can check dependencies from the campaigns launch pad. When you try to
delete a campaign with dependencies, Oracle Eloqua displays them for you so that you can

resolve them.

To delete a campaign:

1. Navigate to Orchestration , then click Campaigns.

2. Search for the campaign you want to delete.

3. Delete the campaign:

* Inthe classic Ul, right-click the campaign in the search results and click Delete.

In the Redwood experience, click Actions > Delete.



Campaign canvas elements

The campaign canvas includes a wide variety of elements that you can use to create rich,

multi-step campaigns that meet your marketing goals.

Each element has its own configuration needs: some elements, like Wait, are very
straightforward, while others require a more complex configuration. When you fully
configure an element, it changes color. You must fully configure all elements before you

can activate a campaign.

You can also extend the functionality of the campaign canvas by using Oracle Eloqua
AppCloud appsOracle Eloqua AppCloud apps
(https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx). These apps

enable you to integrate your campaign with other systems like WebEx or GoToWebinar.

Example of using elements in campaigns

Using the campaign canvas, you can rapidly assemble marketing campaigns, either
simple or complex, using elements such as segments, emails, landing pages, decision
rules, and actions (wait or send to program). To create a campaign, you must follow these

simple steps:

1. Specify a start and end date for the campaign, this is the period during which the campaign will

be active.
2. Drag all of the elements onto the campaign canvas.

3. Double-click each element and select the specific instance of the element.


https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx
https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx

4. Connect the elements together and save.

Slote: A campaign is not active until you click the Activate button in the upper-right

corner.

The following are some examples of the types of marketing campaigns you can build

using the campaign canvas.
Example 1: Creating a simple email campaign

The simplest campaign is one where you send an email to a segment of contacts. For

this, you only need a segment element with an email element.

Segment Members
Oracle Segment

Email
Welcome to Elogual

Example 2: Setting up a simple campaign with a landing page

You can also distribute an email that provides a click-through link to a landing page. Make

sure that the link in the email goes to the landing page you specify.

MNote: If the email contains a link to a landing page, the campaign canvas will

automatically create a connection between them.



Segment Members
Oracle Segment

Email
Welcome to Elogual

o

Wait
1 Day

i

Email
2017 Upcoming Event Promotion

—\

Landing Page (reporting o...
Default Webcast Registration

Example 3: Testing for a click-through on a link

You might want to use a decision rule to test whether the recipient clicks-through on a
specific link in the email, then execute other rules or actions based on whether they did.
In the example shown, recipients are sent another email if they click through on the link,
but if not, they're sent to a lead nurturing program (the name of the specific step in the

program is shown in the send to program element).



Segment Members
ACME Business Units - A

Email

Welcome to Eloqual
Clicked Email?
Welcome to Eloqual

-\\ /'/ f_h\\\

Add to Program Move to Campaign
North America Product Line Eé New and Improved
Step: Listener Email: copy email

®Note: The number of clicks, when the clickthrough occurred, and the duration of

the evaluation window going forward are included in the Clicked Email? element.

Clicked Email?
MA- Q116 Breakfast Series: Toronto

Step name: -

Clicked Email?

Choose an email to evaluate:
MNA - Q1/16 Breakfast Series: Toronto ~ m £

Clicked atleast 1 |: time(s) within the last 2 Week(s)

/ Evaluation period: 1 Monthis) |:

A small stopwatch ¥ icon is added to the element after you configure it.
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Example 4: Including a wait time

Another example is to send an email, then to wait a set time and then send another email.
This can be useful if you are starting with a distribution list of committed recipients and

don't need an "opt in" to send the second email.

Segment Members
Oracle Segment

£

Email
Awareness Email #6 - Blog P..

L—a—

Wait
3 Days

yow

e

Email
B2B Compare Email #1: Event...

Configuring campaign canvas elements: Audience

When you add an audience element to your campaign canvas, you are identifying the
contacts to include as members of the campaign. The following audience elements are
available:

* Segment members

* Cloud Feeder



Segment members

Add members to the campaign flow by using a contact segment.

Segment Members

Double-click to choose

Step name:

Segment Members

Choose a segment or create a new one:

Type here... -

New...

Choose when to add segment members to the campaign:
IZ§J Add members once when the campaign is first activated.

IZ:ZI Add members regularly until campaign is deactivated.

Day(s) v

To configure the Segment Members element:

1. Type a descriptive name for the step in the Step name field.

o Select the segment from the drop-down list, or click Folder ™ and browse to the segment.

Alternatively, you can click New to create a new segment.

3. Choose how you want the segment members to be evaluated:
¢ To evaluate the segment one time, click Add members once when the campaign is first activated.

After you activate the campaign, members of the segment at the time of activation enter the


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Segments

campaign. No new segment members can enter the campaign after it is activated. If you use this

option, the element appears gray on the canvas

¢ To evaluate the segment continuously while the campaign is active, click Add members regularly
until campaign is deactivated and specify how often to evaluate the segment. Oracle Eloqua will
evaluate the segment according to the frequency you specify and add new segment members to the

campaign. The default re-evaluation frequency is every 1 day. If you use this option, the element

appears green on the canvas

Cﬁnportant: Avoid evaluating the segment hourly as this can overload the system. ltis

recommended to evaluate as infrequently as possible, e.g. once a day.

Rlote: For campaigns activated with a segment re-evaluation in release 25B or later, the re-

evaluation will be calculated precisely using the last activation time and the number of re-

evaluations.

Rjote: For Re-evaluation Frequency, periods of time are assigned the following seconds

values:

Time Seconds Value
Day 86,400

Week 604,800

Month 2,628,000

4. Click outside the element configuration window to apply your changes. After you add the

segment, you'll notice the step indicates a count of the segment members.



Segment Members
ACME Business Units

After you activate the campaign, you can see the number of contacts who have entered
the segment members step so far. See Tracking segment members in your campaigns

and programs for more information.

Segment Members Segment Members
ACME Business Units ACME Business Units

L/_?DDD contacts entered - K 2352 contacts entered -«

Cloud Feeder

Oracle Eloqua AppCloud apps extend Oracle Eloqua's functionality and allow you to

integrate Oracle Eloqua with external systems. These apps rely on external systems and

require additional configuration so that your campaign progresses even if the app is down

or unresponsive. Oracle Eloqua prevents you from adding an app to the canvas if itis
down or unresponsive. This prevents you from building a campaign that uses a broken or

deactivated service.

®MNote: Your administrator must add AppCloud apps to your catalog and install

them before you can start using them in your campaigns.

The product documentation for these apps will help you configure them.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=TrackingSegmentsCanvas
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=TrackingSegmentsCanvas
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps

Configuring campaign canvas elements: Assets

When you add assets to your campaign you are adding the elements with which your
contacts will interact. The following is a list of the assets available on the campaign

canvas:
¢ Email
* SMS
* Form

* Landing Page

Email

Send your campaign members emails in your campaign flow.



Email
Double-click to choose. ..

Step name:

Email

Choose an email or create a new one:

* ||

Hew... Preview...

Sending Options  Scheduling Routing

To configure the Email asset:

1. Type a new name into the Step name field.

o Select an email from the drop-down list or click Folder ™ and browse to the email. To create a

new email, click New.
3. Select additional configuration options by clicking on the corresponding tabs:

* Signature: Enable the Use a Signature check box (optional), then select either Send
using a dynamic signature rule or Send on behalf of a single user, and select an option

from the corresponding drop-down list. Learn more about signature rules. In addition, if a


SignatureRules.htm

signature layout was added to the email, the signature will be dynamically be populated

based on the sender. Learn more about signature layouts.

The sender's user account does not need to be active nor does the person associated to
the user account need to have access to Oracle Eloqua. The user account and
associated signature fields will be used to populate the email sender and sender

information like a signature where applicable. Learn more.

* Sending Options: Select the check box next to the sending options that you want to

utilize for this email.

+ Break send into smaller batches: This option allows you to break the overall email send into

smaller batches. Specify the number of hours or days and then choose the correct time unit.

* Allow emails to be re-sent to past recipients: This option allows emails to be re-sent to past

recipients of the same email.

®Sote: In most cases, you will not want to select this option as it increases the
likelihood that the recipient will report your email as spam. Only select this option if the

email contains crucial or emergency information, or if a critical correction has been

made to the content of the original email.

¢ Include List-Unsubscribe header: This option includes a group or global list-unsubscribe

header with the default as the group unsubscribe option.

¢ Send email to master exclude members: This option sends the email to contacts on the
master exclude list. This ensures that members on this list do not miss out on critical non-

marketing emails, such as product information.

¢ Send email to unsubscribed members: This option sends the email to unsubscribed
contacts, this ensures that unsubscribed members do not miss out on critical non-marketing

emails, such as product information.

* Scheduling: Select the check box next to the scheduling option that you want to use for

this email.


SignatureLayouts.htm
CreatingIndividualUsers.htm#Add

« Only send during certain days and hours: Select the days and the specific time range that

you want to send the email. The default time zone is your local time zone.

If you would like to configure a batch send and distribute it evenly over a specific period, you

must configure both the Sending and Scheduling options.

* Under Sending Options, select Break into smaller batches and specify the sending period in hours

or days.

* Under Scheduling, select Only send during certain days and hours and specify the start and end

time.

@B(ample

As part of your campaign, you want to send an email to 100,000 contacts over a five
day period between 9:00 am - 5:00 pm ET so that a group of 20,000 contacts receives
the email each day.

To configure the email options in your campaign:

1. Double-click the email element on the campaign canvas.

2. Click Sending Options and select Break into smaller batches. Set the Sending Period to

5days.
3. Click Scheduling and select Only send during certain days and hours. Set the Start Time

for 9:00 AM and End Time for 5:00 PM.

Your campaign is now configured to send the email to 20,000 contacts each day for the

five day period.

¢ Enable Send Time Optimization: This option located under the Scheduling tab of an Email

asset allows marketers to send emails at the optimal time for each contact. An email with Send

Time Optimization enabled is indicated with on the Campaign Canvas. Learn more about

Send Time Optimization.

G‘mportant: Effective June 12, 2025, Oracle Eloqua's Advanced Intelligence (Al)
features are available for all customers. To enable Eloqua's classic and Generative Al


../../../../../../Content/Help/AdvancedIntelligence/SendTimeOptimization/STO_SendTimeOptimizationOverview.htm
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/Help/AdvancedIntelligence/AdvancedIntelligenceOverview.htm
https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/Help/AdvancedIntelligence/AdvancedIntelligenceOverview.htm

(Gen Al) functionality, open a service request with Oracle Support. Please review our

product notice for more information.

» Optimization: Select whether to Optimize by time of day or Optimize by time of day and day of
week when sending the email. With Optimize by time of day, a contact will receive emails at the
optimal time of day, within 24 hours of trigger. With Optimize by time of day and day of week,
Elogua will determine which combination of time of day and day of week is optimal for each contact,

within the next 7 days of trigger.

* Routing: Enable the check box if you want to automatically route contacts excluded from

the email send. Click Choose and specify a target.

SMS

Umportant: This feature is only available if your organization has purchased SMS

services. Please contact your account manager for additional information and

pricing.

Send your campaign members SMS messages in your campaign flow.


https://support.oracle.com/
https://community.oracle.com/customerconnect/discussion/881211

SMS
IND-5MS

Step name:

SMS

Choose an SMS:
IMD-SMS -

.I
“

o You have chosen a Transactional SMS

R ERTT = Sending Options  Scheduling  Routing

Send SMS messages to this Phone number

'@' Mobile Phone (C_MobilePhone)

() Business Phone (C_BusPhone)

To configure the SMS asset:

1. Type a new name into the Step name field.

o Selectan SMS message from the drop-down list or click Folder and browse to the email. To

j .

create a new SMS message, click New

3. Select additional configuration options by clicking on the corresponding tabs:

* Phone Number: Select which phone number Eloqua should send the SMS message to.

You can choose from two contact fields: Mobile Phone or Business Phone.



* Sending Options: Choose your sending options.
¢ Allow SMS to be re-sent to phone numbers previously sent to: Select the check box to allow
resending the SMS message to the same phone number. Additionally, you can specify the

time period to check against for the resending option.

For example, if you select 2 months, this would prevent resending the same SMS message to
the same phone number within the last 2 months. If the same message was sent 3 months

ago, the message would resend.

* Send SMS to opted-out phone numbers: If you have selected a transactional SMS message,
select this check box to send this message to phone numbers that have opted-out of SMS

communications. You must have permission to access this check box.

* Scheduling: Select the check box next to the scheduling option that you want to use for

this SMS.
« Only send during certain days and hours: Select the days and the specific time range that

you want to send the SMS. The default time zone is your local time zone.

* Routing: Enable the check box if you want to automatically route contacts excluded from

the SMS send. Click Choose and specify a target.

Form

If you add an email that links to a form or to a landing page with a form, you can add that
form to the campaign canvas for reporting purposes. After you add a form to the canvas,
you do not connect it to other campaign elements. It is on the canvas so that it is visible to

users and included in reporting.



Form (reporting only)
Double-click to choose. ..

Step name:

Form (reporting only)

Choose aform or create a new one:

Hew...

To configure the Form asset:

1. Type a new name into the Step name field.

o Select a form from the drop-down list, or click Folder ™ to browse to the form. To create a new

form, click New.

Landing Page

If you add an email that links to a landing page, you can add that landing page to your
campaign canvas. This allows you to include landing page activities in your campaign
reports. After you add a landing page to the canvas, you do not connect it to other

campaign elements. It is on the canvas so that it is visible to users and included in

reporting.



®Note: If a landing page on the canvas contains a form that is also on the canvas,

Oracle Eloqua connects the two on the canvas to show the relationship.

Landing Page (reporting o...
ExamplelLP

Form (reporting only)
Sample Form

To configure the Landing Page asset:
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Landing Page (reporting only)
Double-click to choose. ..

Step name:

Landing FPage (reporting only)

Choose a landing page or create a new one:

*x

Hew... Preview...

Llse any following LRLs when linking to this page:
(Mo Landing Page Selected)

1. Type a new name into the Step name field.

o Select a landing page from the drop-down list, or click Folder to browse to the landing

page. To create a new landing page, click New.

Configuring campaign canvas elements: Decisions

When you add a decision element to your campaign, you are customizing the campaign
experience for your contacts based on how they interact with your material. All decisions
have a Yes path and No path. If the criteria of the decision is met, then the contact flows
down the Yes path. If the criteria of the decision is not met, then the contact flows down

the No path.



Date- and time-based decisions previously defaulted to Eastern Standard Time (UTC -
5:00). New Oracle Eloqua users will automatically default to their respective time zone,
but current users must turn on this feature by logging a service request with My Oracle

Support. The feature cannot be reversed once enabled.
The following is a list of each Decision element available on the campaign canvas:

* Clicked Email?

* Compare Contact Fields
* Compare Custom Object Fields
* Shared List Member?

* Shared Filter Member?
* Opened Email?

* Sent Email?

* Submitted Form?

* Visited Website?

* Audience Split

* Compare Date

* Clicked SMS?

* Replied to SMS?

* Sent SMS?

* Cloud Decision


https://support.oracle.com/portal/
https://support.oracle.com/portal/

Clicked Email?

Route contacts depending on whether they clicked through on any link in a selected

“.| Clicked Email?
Double-click to choose. ..
Step name:

Clicked Email?

email.

Choose an email to evaluate:

~ m 7
Clicked atleast 1 % fime(s) within the last 1 Week(s) =
Evaluation period; 0 Day(s) =

To configure the Clicked Email element:

1. Type a new name into the Step name field.

o Select the email from the drop-down list, or click Folder and browse to the email.

3. Set the evaluation details by selecting:

¢ The minimum number of times that a link in the email was clicked, choose from the

number drop-down list.

* The time period during which it was clicked (within the last...), type a number in the box

then choose if it is hours, days, weeks, or months.



» The Evaluation period, the time period in which you want to evaluate for this criterion.

Type a number in the box, then specify if it is hours, days, weeks, or months.
¢ If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

¢ If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every

10 minutes.

¢ If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every

30 minutes.

* [fthe evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation

once every hour.

Compare Contact Fields

Evaluate and route contacts based on the values (or lack thereof) in a selected contact

field.

Compare Contact Fields
Criterion is not yet defined

Step name:

Compare Contact Fields

Evaluate Contacts whose...

4 b

Evaluation period: 0 Day(s)

To configure the Compare Contact Fields element:



1.

2.

Type a new name into the Step name field.

In the Evaluate Contacts whose section, select values in each of the fields:

a. Select a field: Select a field from the drop-down list, or narrow the selection by typing the name in the

field.

Select an operator: Select the operator for the comparison. this value tells Oracle Eloqua how you
want to route the contacts based on the specified field. The operators vary depending on the field type
that you selected. For instance, if you select Date Created as the field type, you might choose Before
as the operator, to look for contact profiles created before a certain date. If the selected field is Job

Role, the operator might be Contains, allowing you to search for a keyword in a contact's job title.

c. Enter avalue: Type the value or select a value from the drop-down. This information is the point of

comparison within the specified contact field.

3. Setthe Evaluation period, the time period in which you want to evaluate for this criterion. Type a

&

number in the box, then specify if it is hours, days, weeks, or months.

If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10

minutes.

If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30

minutes.

If the evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every

hour.

Example: In the image below, the State or Province field is being evaluated to find

those contacts whose information is an exact match for the specified value, in this

case, "Ontario." Contacts with "Ontario" in this field will be routes along the Yes

path, and all other contacts will be routed along the No path (if there is one).



Compare Contact Fields
Contacts who have a "State or Province® field having a value that is equal to “Ontaric®
X~ K

Compare Contact Fields

Step name

Evaluate Contacts whose..

State or Province -

[Jnot  exactly =
Ontario -

Evaluation period: 14 Day(s) =

Compare Custom Obiject Fields

Evaluate and route contacts based on values populated in the contact's linked custom

object fields.

EExample: You may have a custom field called "Salary" set as a picklist, and based

on the value selected for a contact, add (or exclude) that contact from your

segment.



Compare Custom Object Fields
Double-click to choose...

Step name:

Compare Custom Object Fields

Evaluate Contacts whose...

Evaluation period: 0 Dayis) -

To configure the Compare Custom Object Fields element:

1. Type a new name into the Step name field.

2. Inthe Evaluate Contacts whose section, select values in each of the fields:

¢ Select a Custom Object Set: Choose a custom object set from the drop-down list.

« Select a field: Choose the field containing the data that you wish to use for comparison (filtering)

purposes.

» Select an operator: This value tells Oracle Eloqua how to route the contacts. The operators vary

depending on the field type that you selected.

* Enter a value: Type the value or select a value from the drop-down. This information is the point of

comparison within the specified contact field.

3. Setthe Evaluation Period, the time period in which you want to evaluate for this criterion. Type a

number in the box, then specify if it is hours, days, weeks, or months.



« If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

¢ If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10

minutes.

« If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30

minutes.

* Ifthe evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every

hour.

Shared List Member?

Evaluate and route contacts depending on whether they are in a selected contact list.

“"| shared List Member?
Double-click to choose...

Step name:

Shared List Member?

Choose a contact list to evaluate:

~ m 7

Evaluation period: 0 Day(s)

4k

To configure the Shared List Member? element:

1. Type a new name into the Step name field.

2 Select the contact list from the drop-down list, or click Folder ™ and browse to the list.



3. Setthe Evaluation Period, the time period in which you want to evaluate for this criterion. Type a

number in the box, then specify if it is hours, days, weeks, or months.
¢ If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

« If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10

minutes.

« If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30

minutes.

* Ifthe evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every

hour.

Shared Filter Member?

Evaluate and route contacts based on whether they are in a selected shared filter.

"] shared Filter Member?
Double-click to choose. ..

Step name:

Shared Filter Member?

Choose a shared contact filter to evaluate:

~

Evaluation period: 0 Day(s) =

To configure the Shared Filter Member? element:

1. Type a new name into the Step name field.

o Select a shared filter from the drop-down list, or click Folder ™ and browse to the list.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SharedFilters

3. Setthe Evaluation Period, the time period in which you want to evaluate for this criterion. Type a

number in the box, then specify if it is hours, days, weeks, or months.
¢ If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

« If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10

minutes.

« If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30

minutes.

* Ifthe evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every

hour.

Opened Email?

Evaluate and route segment members differently depending on whether they opened a

specific email at least a selected humber of times.

: Opened Email?
Double-click to choose...

Opened Email?

Step name:

Choose an email to evaluate:

~ m £

Opened at least 1 % time(s)within the last 1 Weekis)

4

Evaluation period: 0 Day(s)

4 b

To configure the Opened Email? element:



1. Type a new name into the Step name field.

2 Select an email from the list, or click Folder and browse to the email.

3. Setthe evaluation details by selecting:

¢ The minimum number of times that the email was opened. Choose from the number drop-down list.

¢ The time period during which it was opened (within the last...). Type a number in the box then specify

if it is hours, days, weeks, or months. .
* The Evaluation period, the time period in which you want to evaluate for this criterion. Type a number
in the box , then choose if it is hours, days, weeks, or months.
 Ifthe evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.
* If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10 minutes.
* |f the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30 minutes.

* |f the evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every hour.

Sent Email?

Evaluate and route contacts that have been sent a specific email separately from those

that have not.

Sent Email?
Double-click to choose...

Step name:

Sent Email?

Choose an email to evaluate:

=
*r

Evaluation period: 0 Day(s) -



To configure the Sent Email? element:

1. Type a new name into the Step name field.

o Select the email from the drop-down list, or click Folder ™ and browse to the email.

3. Setthe Evaluation Period, the time period in which you want to evaluate for this criterion. Type a

number in the box, then specify if it is hours, days, weeks, or months.
¢ If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

« If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10

minutes.

* [f the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30

minutes.

¢ Ifthe evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every

hour.

Submitted Form?

Evaluate and route contacts that have submitted a specific form any number of times

during an evaluation period.



Submitted Form?
Double-click to choose. ..

Step name:

Submitted Form?

Choose aform to evaluate:

>~ m £
Submitted within the last 1 Week(s) =
Evaluation period: 0 Day(s) =

To configure the Submitted Form? element:

1. Type a new name into the Step name field.

o Select the form from the drop-down list, or click Folder ™ and browse to the form.

3. Set the evaluation parameters by selecting the time period during which the form must have
been submitted to be routed differently (Sent within the last...). Type a number in the box then

choose if it is hours, days, weeks, or months.

@B(ample: If you set the value as 1 week, Oracle Eloqua would route segment members

that submitted a form during the past week separately from those that did not.

4. Setthe Evaluation period, the time period in which you want to evaluate for this criterion. Type a

number in the box, then specify if it is hours, days, weeks, or months.



« If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

¢ If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10

minutes.

« If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30

minutes.

* Ifthe evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every

hour.

Visited Website?

Evaluate and route contacts that have viewed any page on your website at least a

selected number of times during a specified period.

Wl visited Website?
1time or more in the last 1 week

Visited Website?

Step name:

Visited at least 1 % time(s)within the last 1 Week(s)

L

Evaluation period: 0 Day(s)

L

To configure the Visited Website? element:



1. Type a new name into the Step name field.

2. Set the evaluation details by selecting:

* The minimum number of times that the website was visited, choose from the number drop-down list.

¢ The time period during which it was visited (within the last...), type a number in the box then choose if

it is hours, days, weeks, or months.

* The Evaluation period, the time period in which you want to evaluate for this criterion. Type a number

in the box then choose if it is hours, days, weeks, or months.

3. The Evaluation period, the time period in which you want to evaluate for this criterion. Type a

number in the box, then specify if it is hours, days, weeks, or months.
¢ If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

« If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every 10

minutes.

* [f the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every 30

minutes.

« Ifthe evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation once every

hour.

Audience Split

Split contacts down different paths by percentages.

-

Audience Split
&0 percent of contacts will go to Yes Path.

. &,

Step name:
Audience Split
Indicate the Percentage to be branched to Yes step.The remaining will branch to no Path.

et e
Yes Mo



To configure the Audience Split element:

1. Type a new name into the Step Name field.

2. Using the slider, indicate the percentage to be branched to Yes and No paths.

Compare Date

Evaluate and route contacts on, before, or after a specific date, or during a period

between two specified dates.

®Note: This decision is not affected by any dates in a contact field or custom object

field.

Compare Date
Criterion is not yet defined

Step name:

Compare Date

Evaluate Contacts ifthe date is

[ ] not -
2

Time zone:
(UTC-05:00) Eastern Time (US & Canada) -



To configure the Compare Date element:

1. Type a new name into the Step Name field.

2. Select an operator from the drop-down list. You choices are: before, after, on or before, on or

after, on, and between. Select to deselect the check box to reverse the operator.

3. Specify the date and time. If you select between as your operator, then you must specify two

dates. The minimum level of a time period between two dates is 5 minutes.

4. Select a time zone from the drop-down box.

Clicked SMS?

(mportant: This feature is only available if your organization has purchased SMS
services. Please contact your account manager for additional information and

pricing.

This step lets you route contacts based on whether or not they clicked on a link in the

selected SMS message.



Clicked SMS§?

Double-click to choose
Step name:
Clicked SMS?
Choose an SMS to track:
Type here =4 Wi
Clicked at least | 1 v | time(s) within the last 1 Week(s) =
Evaluation period: 0 Day(s) =

To configure the Clicked SMS element:

1. Type a new name into the Step name field.
2 Select the SMS from the drop-down list, or click Folder ™ and browse to the SMS.

3. Set the evaluation details by selecting:

* The minimum number of times that a link in the SMS was clicked. Choose from the

number drop-down list.

* The time period during which it was clicked (within the last...). Type a number in the box

then choose if it is hours, days, weeks, or months.

* The Evaluation period. The time period in which you want to evaluate for this criterion.

Type a number in the box, then specify if it is hours, days, weeks, or months.
« If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

* Ifthe evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every

10 minutes.

¢ If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every

30 minutes.



« If the evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation
once every hour.

Replied to SMS?

(mportant: This feature is only available if your organization has purchased SMS

services. Please contact your account manager for additional information and
pricing.

This decision block evaluates incoming SMS replies. It can listen for specific keywords

within those replies, which in turn lets you route your contacts down different paths.
I

Replied To SMS5?
Join us todayl

Step name:

Replied To SMS7?

Choose a message to evaluate:

Join us today!

~ m f
Choose a keyword to listen ta:
START 7
Replied within the last 1 Day(s) -
Evaluation period: 0 Day(s) v

To configure the Replied to SMS element:



1. Type a new name into the Step name field.

2 Select the SMS from the drop-down list, or click Folder ™ and browse to the SMS message
you'd like to evaluate.

3. Choose a keyword to listen to:
An SMS keyword is a word or phrase that your subscribers can text to an SMS code to interact
with your SMS campaign. You can leverage this response activity and decide the next action

based on what was expressed through the response keyword. Use this drop down to choose

the keyword you'd like to evaluate with this decision step.
4. Setthe evaluation details by selecting:

* Replied within the last. Set a limit for the time period during which the client replied to the

message. Type a number in the box, then specify if it is hours, days, weeks, or months.

* The Evaluation period. The time period in which you want to evaluate for this criterion.

Type a number in the box, then specify if it is hours, days, weeks, or months.
¢ If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

¢ If the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation every

10 minutes.

¢ If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation every

30 minutes.

¢ If the evaluation period is set for more than 1 week, Oracle Eloqua will retry the evaluation

once every hour.



Sent SMS?

(mportant: This feature is only available if your organization has purchased SMS

services. Please contact your account manager for additional information and

pricing.

This decision block evaluates outbound messages based on sent status.
I

Sent SMS?
Join us today!

Step name:

Sent SMS?

Choose an SMS to evaluate:

Join us today! ~ m s

Evaluation period: 0 Day(s) A

To configure the Sent SMS element:

1. Type a new name into the Step name field.

o Select the SMS from the drop-down list, or click Folder ™ and browse to the message you'd

like to evaluate.



3. Set the Evaluation period. The time period in which you want to evaluate for this criterion. Type

a number in the box, then specify if it is hours, days, weeks, or months.
* If the evaluation period is set to 0, Oracle Eloqua will evaluate the contact immediately.

* [f the evaluation period is set for 24 hours or less, Oracle Eloqua will retry the evaluation

every 10 minutes.

* If the evaluation period is set for more than 1 day, Oracle Eloqua will retry the evaluation

every 30 minutes.

* If the evaluation period is set for more than 1 week, Oracle Eloqua will retry the

evaluation once every hour.

Cloud Decision

Oracle Eloqua AppCloud apps extend Oracle Eloqua's functionality and allow you to
integrate Oracle Eloqua with external systems. These apps rely on external systems and
require additional configuration so that your campaign progresses even if the app is down
or unresponsive. Oracle Eloqua prevents you from adding an app to the canvas ifitis
down or unresponsive. This prevents you from building a campaign that uses a broken or

deactivated service.

®Note: Your administrator must add AppCloud apps to your catalog and install

them before you can start using them in your campaigns.

To configure the Cloud Decision element:


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps

1. Enable the check box next to Automatically route contacts with errors from cloud app to

prevent contacts from becoming "stuck" in an cloud decision step.
o Click Edit L4 to configure the cloud decision. The configuration screen opens in a new tab.

3. Click Save and close the tab once you have completed your configuration.

®Note: You cannot activate a campaign until you fully configure the campaign's

AppCloud app.

Configuring campaign canvas elements: Actions

When you add an Action element to a campaign you are specifying campaign details
such as where and when contacts will be redirected, or if they will be added to a certain

list or to another campaign.
The following is a list of each Action element available on the campaign canvas:

* Add to Campaign

* Add to Program Builder
* Move to Campaign

* Add to Shared List

* Move to Program Builder
* Move to Shared List

* Wait

* Remove from Shared List



* Addto Program
* Cloud Action

* Update Rules

Add to Campaign

This element lets you add segment members from the current campaign to specific

elements (including cloud step elements) in a different campaign for further routing and

processing.

To configure the Add to Campaign element:

Add to Campaign
Double-click to choose...

Step name:

Add to Campaign

Choose a step in anather campaign:

No element selected

Choose...

1. Type a new name into the Step name text box.

2. Click Choose to open the Choose a Campaign Step window.



3. Select a campaign from the Choose a campaign drop-down list. The selected campaign

opens.
4. Select the specific element in that campaign to which you want to send the members from your

current campaign, then click Choose.

The window closes and the element from the other campaign appears in the Add to
Campaign configuration window. The name of the added campaign and campaign

element are now displayed in the new element.

Add to Program Builder

This element lets you add segment members to a selected step in an automated

marketing program for further routing and processing.

To configure the Add to Program Builder element:

Add to Program Builder
Double-click to choose. ..

Step name:

Add to Program Builder

Choose a program:

1. Type a new name into the Step name text box.

2. Select a program from the Choose a program drop-down list or type the name in the field.



3. Click a program step from the Choose a program step drop-down list. This is the specific step

in the automated marketing program to which you want to send the campaign members.

Move to Campaign

This element lets you move segment members from the current campaign to specific
elements (including cloud step elements) in a different campaign for further routing and

processing.

To configure the Move to Campaign element:

Move to Campaign
Double-click to choose...

Step name:

Maove to Campaign

Choose a step in another campaign:

No element selected

Choose...

1. Type a new name into the Step name text box.
2. Click Choose. The Choose a Campaign step window opens.

3. Select a campaign from the Choose a campaign drop-down list. The selected campaign

opens.



4. Click the specific element in that campaign to which you want to move the campaign members

from your current campaign, then click Choose.

The window closes and the element from the other campaign appears in the Move to
Campaign configuration window. The name of the other campaign and campaign

element are now displayed in the new element.

Add to Shared List

This element lets you add segment members in the current campaign to a shared contact
list. Adding members to a shared list is a dynamic process. As contacts progress through

the campaign steps, Oracle Eloqua adds them to the shared list that you have specified.

Add to Shared List
Double-click to choose...

Step name:

Addto Shared List

Choose a contact list to evaluate:

New...

To configure the Add to Shared List element:

1. Type a new name into the Step name text box.

2. Select a contact list from the Choose a contact list to evaluate drop-down list, or click File

Chooser and select one from the chooser. To create a new list, click New.

ry

3 Click Edit and configure the contact list.



Move to Program Builder

This element lets you move campaign members to a program created using the program

builder.

Move to Program Builder
Double-click to choose. .

Step name:

Maove to Program Builder

Choose a program:

To configure the Move to Program Builder element:

1. Type a new name into the Step name text box.
2. Select a program from the Choose a program drop-down list, or type the name in the field.

3. Select a program step from the Choose a program step drop-down list. This is the specific step

in the program to which you want to move the campaign members.

Move to Shared List

This element lets you move segment members to a shared list that can be used by other

marketers (users) in your organization in campaigns and segments.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ProgramBuilder
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ProgramBuilder

To configure the Move to Shared List element:

Move to Shared List
L a Double-click to choose. ..

Step name:
Move to Shared List

Choose a contact list to evaluate:

New...

1. Type a new name into the Step name text box.

2. Select a contact list from the Choose a contact list to evaluate drop-down list, or click File

Chooser ™ and select one from the chooser. To create a new list, click New.

Wait

This element allows you to specify how much time will elapse between steps of your

campaign. You can also set up a wait step notification for when contacts enter the step.

EExample: If you want to send an email alerting contacts and prospects to register
for an upcoming seminar, after the initial email step, you can add a wait step. You
can specify an amount of time to wait (hours, days or weeks) before continuing on

to the next step, perhaps sending a reminder to those who have not yet responded.



N wait
L° J 1 Week

Step name:

Wait

Choose how long contacts should waitin this step:

{i} Wait for a set amount of time:

1 Week(s) =

() Wait until a specific date and time:

[ ] Send a nofification to the notification center when a contact
enters the step

To configure the Wait element:

1. Type a new name into the Step name text box.

2. Select one of the following options to determine how long the wait interval should be:

» Wait for a set amount of time: Specify the number of hour(s), day(s), week(s) or month(s) for the wait

period.

* Wait until a specific date and time: Set a specific date and time as the target wait period. Confirm the

correct time zone is selected.

[N

Note: If Daylight Savings Time affects your time zone, a message shows you how the time will

be adjusted.



Step name:

Wait

Choose how long contacts should wait in this step:

() Wait for a set amount of time:

Weeki(s) —

bl

I@} Wait until a specific date and time:
4712016 B 12 © 00 AM

Time zone:

GMT Offset Wil Adjust +1.00 for Daylight Savings

enters the step

Remove from Shared List

This element lets you remove segment members from a shared list used by other

marketers (users) in your organization in campaigns and segments.

r 1 Remove from Shared List

L a Double-click to choose..

Step name:

Remoaove from Shared List

Choose a contact list to evaluate:

New...

To configure the Remove from Shared List element:



1. Type a new name into the Step name text box.

2. Select a contact list from the Choose a contact list to evaluate drop-down list, or click File

Chooser = and select one from the chooser.

Add to Program

This element lets you add segment members to a selected step in an existing program,

built using the program canvas.

Add to Program
Double-click to choose...

Step name:

Add to Program

Choose a step in another program:

No element selected

Choose...

To configure the Add to Program element:

1. Type a new name into the Step name text box.
2. Click Choose to open the Choose a Program Step window.

3. Select a campaign from the Choose a Program drop-down list. The selected program opens.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=ProgramCanvas

4. Select the specific element in that program to which you want to send the members from your

current campaign, and then click Choose.

The window closes and the element from the other campaign appears in the Add to
Program configuration window. The name of the added program and the program

element are now displayed in the new element.

Cloud Action

Oracle Eloqua AppCloud apps extend Oracle Eloqua's functionality and allow you to
integrate Oracle Eloqua with external systems. These apps rely on external systems and
require additional configuration so that your campaign progresses even if the app is down
or unresponsive. Oracle Eloqua prevents you from adding an app to the canvas if itis
down or unresponsive. This prevents you from building a campaign that uses a broken or

deactivated service.

®MNote: Your administrator must add AppCloud apps to your catalog and install

them before you can start using them in your campaigns.

To configure the Cloud Action element:

1. Enable the check box next to Automatically route contacts with errors from cloud app to

prevent contacts from becoming "stuck" in an cloud action step.

o Click Edit ’ to configure the cloud action.

3. Configure the element as desired.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps

a. Scheduling: Select the days and the specific time range that you want to send the email.

b. Routing: Enable the check box if you want to automatically route contacts excluded from the email

send. Click Choose and specify a target.

4. Click Save and close the tab once you have completed your configuration.

®Note: You cannot activate a campaign until you fully configure the campaign's

AppCloud app.

Update Rules

Move contacts through a rule set in order to update contact fields or custom object
records.

Update Rules
Lead Source Original

Step name:

Update Rules

Rule Set:

Lead Source Criginal -

Date Stamnp

Lead Source Qriginal

To configure the Update Rules element:

1. Type a new name into the Step name text box.

2. Select a rule set from the Rule Set drop-down list or type the name in the field.



Campaign reporting and metrics

After you've launched a multi-step campaign or simple email campaign, you can use

various metrics to measure the campaign's performance.

(mportant: Campaign operational reports only report on the last 3 months of
campaign data. If you need to look further back into a campaign's history, use

Insight reports or Oracle Eloqua dashboards

Accessing operational reports from a campaign

You can access reports directly from a campaign. If you want to report on multiple
campaigns or report on a campaign's performance beyond the last 3 months, you should

use Insight reports.

To access the operational reports:

1. Navigate to Orchestration , then click Campaigns.

2. Open the campaign you want to report on.

3. Choose an option:

* From the campaign canvas, click [ Operational Reports on the right side.

b
* From a simple campaign or A/B testing campaign, in the classic Ul click Actions and then

click Operational Reports. In the Redwood experience, click View Operational Reports.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=OracleBI
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CTip: You can download the Campaign Entry and Campaign Exit reports to a .csv

or Microsoft Excel file. To view and export a report of segment members within a

campaign, see Viewing segment members in campaigns and programs.

Overview of campaign operational reports

MNote: You must have the View Operational Reports action permission to access

operational reports.

The following table describes the reports available from a campaign:

Report
Campaign Audit

Campaign Email Statistics

Description

The campaign audit provides a history of a campaign's
creation, modification, activation, or deactivation. You can
use this report to see who made changes and when. If you
have a large team of marketers creating campaigns in
Oracle Eloqua, the audit can help ensure transparency
and organizational visibility.

The email statistics report displays recent activity for any
emails that are a part of a campaign.

This report shows the frequency and success rate of email
delivery and performance (such as opens, clickthroughs,
etc.).

If your campaign has multiple emails being sent at
different points, the report can offer information about to
which emails are generating interest or keeping people's
attention, and which emails are being ignored or otherwise
prompting contacts to unsubscribe.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ViewingSegmentMembers
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Report

Campaign Entry

Campaign Exit

Campaign SMS Statistics

Description

Overall, use this report as a spot-check to ensure that your
campaign is working.

The campaign entry report shows how and when contacts
entered a campaign.

The primary ways a contact enters a campaign are from
segments, from other campaigns and programs, or from
form processing. However, this report can show additional
ways such as through a custom object set or cloud feeder.

Use this report to ensure that your campaign is performing
correctly, and that contacts are entering the campaign
from the intended sources.

The campaign exit report shows how and when contacts
exited a campaign.

Use this report to ensure you understand why contacts
exited a campaign, ensure that the campaign is
performing as expected, and that contacts are flowing the
correct campaign path.

(mportant: This feature is only available if your
organization has purchased SMS services. Please
contact your account manager for additional

information and pricing.

The SMS statistics report displays recent activity for any

SMS messages that are a part of a campaign.

This report shows the frequency and success rate of SMS
delivery and performance (such as received,

clickthroughs, and so on).



Report

Stuck Records Report

Description
If your campaign has multiple SMS messages being sent

at different points, the report can offer information about
which SMS messages are generating interest or
generating engagement, and which messages are being

ignored or otherwise prompting contacts to unsubscribe.

Overall, use this report as a spot-check to ensure that your

campaign is working.

(mportant: Phased rollout of the Stuck Records

Report will begin in release 25C.

The stuck records for the selected canvas from the Stuck

Records Report (All Canvases).

Understanding campaign performance metrics

The following table describes the metrics used to measure campaign performance. For

multi-step campaigns, these metrics are available from the Campaign Email Statistics

report. For simple email campaigns or A/B testing campaigns, you can view these metrics

once your email is sent.

CTip: For multi-step campaigns, you cannot view form performance rates from the

Campaign Email Statistics report. To view form performance information for a multi-

step campaign, use Insight reports.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=OracleBI

SMS metrics

Metric Description
Sent The total SMS messages sent.
Failed The total number of failed messages. Failed messages were not sent at

all. A message failure could be a skipped message (no code available for
the country) or an error with the SMS service.

Delivered  The total SMS messages delivered.
Hard The total messages that returned a hard bounceback. A hard bounce is a
Bounceback
message that permanently could not be delivered.
A common reason for hard bounces includes an invalid phone number.
For more information, see About bounces.
Soft The total messages that returned a soft bounceback. A soft bounce is a
Bounceback

message that temporarily could not be delivered. These bounces may still

be delivered at another time.

For more information, see About bounces.

Clickthrough The total clickthroughs. This includes multiple clicks by the same
recipient. System Action links are not tracked.

Unique The total recipients that clicked at least one tracked link in an SMS
Clickthroughs

message. One clickthrough is counted for each recipient that clicked a link

in the SMS.

Opt-Out

(Keywords) The total opt-out responses received.

Email metrics

Metric Description
Sent The total emails sent.

Total Delivered The total emails delivered. (Total Sends - Total Bouncebacks)


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Bounces
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Metric

Hard Bounces

Soft Bounces

Delivery Rate

Total Opens

Unique Opens

Open Rate
Total Clicks

Unique
Clickthroughs

Description

®MNote: A sent email is considered delivered unless the
receiving ISP reports a bounceback. Because there can be
delays in the ISP sending that bounceback report, the total
delivered emails may change over time.

The total emails that returned a hard bounceback. A hard bounce is
an email that permanently could not be delivered.

Some common reasons for hard bounces include an invalid email

address or domain name for email messages.

For more information, see About bounces.

The total messages that returned a soft bounceback. A soft bounce
is a message that temporarily could not be delivered. This could
mean that the email address is valid, but the recipient's inbox was
full, the mail server was unavailable, or the email message was too

large. These bounces may still be delivered at another time.

For more information, see About bounces.

The total emails delivered divided by the total emails sent. (Total
Delivered / Total Sent)

The total opens by email recipients (original recipients or email

forwards). An open is counted every time the email is opened.

The total recipients (original recipients or email forwards) that
opened an email at least once. One open is counted for each
recipient that opened the email.

The total opens divided by the total number of times an email was
delivered. (Total Opens / Total Delivered)

The total clickthroughs. This includes multiple clicks by the same
recipient. System Action links are not tracked.

The total recipients (original recipients or email forwards) that

clicked at least one tracked link in an email. One clickthrough is
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Metric Description
counted for each recipient that clicked a link in the email.

Click-Through Rate The total clickthroughs divided by the total number of times an
(CTR) email was delivered. (Total Clickthroughs / Total Delivered)

Unsubscribed The total email recipients that unsubscribed (globally or spam
unsubscribed).
Conversions or Total The total forms submitted. This includes multiple submissions by

Submits
the same contact.

®Note: This is only available for simple campaigns or A/B

testing campaigns. To view form performance information for

a multi-step campaign, use Insight reports.

Campaign The total forms submitted divided by the number of times the form

Conversion Rate
was viewed. (Total Form Submissions / Total Form Views)

®Note: This is only available for simple campaigns or A/B

testing campaigns.

Total Visits The total visits to a landing page associated with the email.

®MNote: This is only available for simple campaigns or A/B

testing campaigns.
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Stuck Records Report (All Canvases)

(mportant: Phased rollout of the Stuck Records Report will begin in release 25C.

To view the Stuck Records Report for all canvases:

1. Navigate to Orchestration , then click Campaigns or Programs.

2. Click Actions > Stuck Records Report

3. Stuck records for the last 3 days are displayed by default, select evaluation period to see stuck

records for up to the last 3 months

4. Todownload the report to a .csv or Microsoft Excel file, click Export. A link to the export file will

be emailed.

The stuck records report includes data on the canvas steps with stuck records and runs

daily with the following criteria:

* Entered step within the last three months
* For App steps: Records have been in the step for 24 hours or more

* For Native steps: Records that do not have a next evaluation set

The report details the following information:

* Canvas Type: The type of canvas.
* Canvas Id: The Id of the canvas.

¢ Canvas Name: The name of the canvas.



* Step ID: The id of the step.

» Step Type: The type of step.

* Step Name: The name of the step.

» Status: The status of records stuck in the step.

* Cloud App Name: The name of the app, if the step is an app step.

* Total Records: The total number of records stuck in the step with the indicated status.
* Earliest Step Entry Time: The earliest step entry time for records stuck in the step.

* Latest Step Entry Time: The latest step entry time for records stuck in the step.

Exporting campaign entry or exit reports

MNote: You must have the View Operational Reports action permission to access

operational reports.

You can export the Campaign Entry and Campaign Exit operational reports directly from
a campaign. These reports detail how and when contacts entered or exited a simple or

multi-step campaign.

(mportant: Campaign operational reports only report on the last 3 months of
campaign data. If you need to look further back into a campaign's history, use

Insight reports or Oracle Eloqua dashboards
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CTip: To view and export a report of segment members in a multi-step campaign,

see Viewing segment members in campaigns and programs.

To export a campaign entry or exit report:

1. Navigate to Orchestration , then click Campaigns.

2. Open the campaign you want to report on.

3. Choose an option:

* From the campaign canvas, click [ Operational Reportson the right side.

»
* From a simple campaign or A/B testing campaign, in the classic Ul select Actions and then

click Operational Reports. In the Redwood experience, click Operational Reports.

4. Choose the entry or exit report.

5. Choose a date range from the Evaluation period drop-down.

6. Inthe classic Ul, click Export. In the Redwood experience, click Export.

7. Configure the export window and click Export.

A link to download the export data will be sent to the specified email address. The

export is available from that link for 14 days.

Viewing the step members report

You can use the step members report to see which contacts are currently in a campaign

or program step. You can view information about the contact as well as their status (for


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=ViewingSegmentMembers

example, awaiting action), when the contact entered the step, and so on. Use this report
to spot-check the step and its current contacts, troubleshoot your campaign or program,

or export it for further analysis.

A

Example: Seeing a lot of contacts in an email element or action step but unsure if
they're successfully executing? Check the Status column to look for possible
setbacks. In the image below, bouncebacks and unsubscribes explain why emails

were not delivered to certain contacts.

Status Entry Time
Excluded from Email: Bounceback 3days ago
Excluded from Email: Unsubscribe 3daysago

Excluded from Email: Unsubscribe 3daysago
Excluded from Email: Bounceback 3daysago

To view a step members report:

1. In the campaign canvas or program canvas, double-click the number of contacts on a decision

or action step.

A
Wait
0.01 Hours

The step members report opens.
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View Campaign Step Members

Campaign Name: Example Campaign Displaying 200 of 5,000 total member(s) q
Step Name: Compare Contact Fields
Contact Vi General Contact Fields -
[] selest All Gontacts ontactiiew
First Name Last Name Title Business Phone Address 1 City Industry Status Email Address Entr

Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action
Awaiting action

Awaiting action

Refresh Export Close

2. Torefresh the report, click Refresh. When you refresh, the contacts in the step may change.

3. Todownload the report to a .csv or Microsoft Excel file, click Export. A link to the export file will

be emailed.



Search for existing opportunities

From the Campaigns area in the application, you can upload opportunities, manage

general settings for opportunities, and search for specific opportunities.

To search for existing opportunities:

1. Navigate to Orchestration , then click Campaigns.

2. Open the Opportunity search:

»
In the classic UI, click Actions , then click Opportunity Search.

In the Redwood experience, click Actions > Search Opportunities.

Opportunity Search

Opportunity Search

Opportunity Name a‘} Search

B viewal

Opportunity Search: Found 0O record(s) Pagelofl <« ¢ > »

3. You can either search for an existing opportunity by one of several different field values. Select

one of the following values:

Opportunity Name: Search on all or part of the name of the opportunity.

Stage: Search on all or part of the name of the opportunity stage (this depends on the values you

used to set up opportunities, but may be values such as Lost, Closed, SQL, MQL, and so on).
Probability Of Closing: These values correspond to the values assigned to each opportunity stage.

Date Created: Use the date in the standard system format. In most cases, this will be MM/DD/YYYY

unless an override is set.

Close Date: Use the date in the standard system format. In most cases, this will be MM/DD/YYYY

unless an override is set.



Alternatively, click View All to see all the available campaign opportunities in the system

4. Fillin the full or partial search value, then click Search.

Matching opportunities in the system are listed. You can click on any opportunity in the

list to see the details for that opportunity.



Configuring opportunity settings

(mportant: Opportunity settings are used as part of your CRM integration.
Typically organizations work with Oracle or with Oracle partners to ensure a

successful CRM integration. Find out more about Oracle's implementation services.

From the Campaigns area in the application, you can upload opportunities, manage

general settings for opportunities, and search for specific opportunities.

To configure opportunity settings:

1. Navigate to Orchestration , then click Campaigns.

2. Open opportunity settings:

»
* Inthe classic Ul, click Actions , then click Opportunity Settings.

¢ Inthe Redwood experience, click Actions > Edit Opportunity Settings.


https://www.oracle.com/marketingcloud/digital-services/implementation.html

Opportunity Settings

Contact to Opportunity Association

The attribution method used to associste contacts to Opportunities is: AN comtacts for the Account that has
been associated to the Qpportanity f Edit

Cpportunity Stage Details

Al Opportunities gre fully created and managed in the CRM system.

T Add Mew Opportunity Stage

Stage Hame Probability of Closing* Indicate Closed/Lost

- Closed 0% v
- Lozt 0% v
- To Gualify 30%
- ML S0%
- SaL 0%

Notes:

- The ‘Propability of Closing’ coliran shows the default probabiliay of the stage, however, individual
apportinitics may have mannally changed to a percentage amount which is different than this default
- Stages flagged as Closed/Lost will not be considered in ROI calcuiations.

Default Revenue Attribution Method

The attribution method used as the default for all Cpportunities is: Aff to the first Campaign f Eciit

. Edit ) . . .
3 Click /B in the Contact to Opportunity Association area. An Opportunities to Campaigns

using Contacts window opens.

Contact to Opportunity Association

Association of Opportunities to Campaigns using Contacts

Elogua will associate Opportunities to Campaigns based on the Contacts that have respended to a Campaign.
From the options below, select which contacts are to be included in this association.

The primary Contact associated to the Opportunity in CRM.
@ All Contacts associated to the Opportunity in CRM
All Contacts in Elogua associated to the Account that is associated to the Opportunity in CRM.

Mote: For the Account option, the Accounts MUST be imported into Eloqua as Companies with the CRM Account ID
and the Contacts MUST be properly linked to the Companies within Eloqua.

ﬂ Close [ Save and Close [ Save

Oracle Eloqua will associate opportunities to campaigns based on the contacts that have
responded to a campaign. You can also select which contacts are to be included in this

association from the following options (choose one):



* The primary Contact associated to the Opportunity in CRM: The opportunity is associated in Oracle

Eloqua with a single contact designated as the primary contact for that opportunity in the CRM.

¢ All Contacts associated to the Opportunity in CRM: The opportunity is associated in Oracle Eloqua

with all contacts associated with the opportunity in the CRM.

¢ All Contacts in Eloqua associated to the Account that is associated to the Opportunity in CRM:
The opportunity is associated to all contacts that are, in turn, associated to an account that is
associated to the opportunity in the CRM. Note that for this option to work, the accounts must be
imported into Oracle Eloqua as companies with the CRM account ID and the contacts must be

properly linked to the companies within Eloqua. (Note: Salesforce account ID is case sensitive.)

4. Click Save and Close to save your changes.

5. Click Add New Opportunity Stage in the Opportunity Stage Details area. The New Opportunity

Stage window opens.

Opportunity Settings

Contact to Opportunity Association

The attribution method used to associste contacts to Opportunities is: AN contacts associated fo the Opportunity _f Edit

Opportunity Stage Details

All Opportunities are fully created and managed in the CRM system

(_ﬂ Add New Opportunity Stage )

Rank Stage Name Probability of Closing* Indicate ClosediLost

A

i 1 - 1 - Proposal & Innovaticn 0%

~

i 2 - 2 - Presentation & Trial D%

A . -

v 3 - 2 - Deal closure 0%

& = fi n

~ 4 - 4 - Deal closure follow-up 0%

6. Complete the settings on the New Opportunity Stage page by:



Mew Opportunity Stage %]

New Opportunity Stage

Opportunity Stage Details

Opportunity Stage Name:
Probability of Closing: 0 %

Indicate ClosedfLost

13 Close LIE! Save and Mew L-d Save and Closs L'!I Save

* Typing a name into the Opportunity Stage Name field.
* Providing a percentage for the Probability of Closing field.

* Selecting the Indicate Closed/Lost check box if the opportunity has been lost or closed

(these are not counted in ROI calculations).

7. Ifthisis the only or final opportunity stage, then click Save and Close. Otherwise, click Save
and New and create an additional stage, then repeat as required and click Save and Close

after the last stage.
8. Click Save and Close when you are finished adding stages.

9. Inthe Default Revenue Attribution Method section, options are provided to let you set up which
campaign responses to include in revenue attribution calculations and how to distribute

attributed revenue. Click Edit and select the configuration settings:



Opportunity Settings

Contact to Opportunity Assodation

The attribution methed used to associate contacts to Opportunities is: Al contacts associated to the Opportunity f Edit

Opportunity Stage Details

All Opportunities are fully created and managed in the CRM system.

s Add New Opportunity Stage

Rank Stage Name Probability of Closing* Indicate Closed/Lost

”~

w 1 - 1 - Proposal & Innovation 0%

s

o 2 - 2 - Presentation & Trial D%

~ 3 3 5 D

w 3 - 3 - Deal closure D%

s

o 4 - 4 - Desal closure follow-up 0%

Notes:

- The Probability of Closing' column shows the defaulf probability of the stage, however, individus!
opportunities may have My changed to a p ge amount which is different than this default.
- Stages flagged as Closed/Lost will nof be considered in ROI calculations.

[ Default Revenue Attribution Method _1

The attribution method used as the default for all Opportunities is- All to the first Campaign f Edit J

* Under Which campaign responses do you want to include in the revenue attribution?, select an
option to indicate which campaign responses you want to include in the revenue attribution. You can
choose to include:

* All campaign responses from Lead Creation in Oracle Eloqua to Opportunity Close in the CRM. If this

setting is selected, attribution will only include opportunities with a Closed Won status.

* Campaign responses from Lead Creation in Oracle Eloqua to only Opportunity Creation in the CRM. If this

setting is selected, attribution will only include Open and Closed Won status opportunities.

¢ Under How do you want to distribute the revenue across the campaigns?, select an option to
indicate how you want to distribute the revenue across campaigns. You can attribute the revenue in

the following ways:

* Evenly across all campaigns
* To the first or last campaign responded to

* By specific percentages to the first, last, and other campaigns

10. Click Save and Close.



"Run as other user" for campaigns

Every time a user a user activates a campaign, that campaign automatically inherits the
contact security labels to which that user is assigned. If a contact in the campaign has a
different security label than the user who activates it, that contact will be removed from

the campaign upon activation. This ensures that label-based access control is enforced,

and that no user can directly affect a contact with a different security label.

Administrators can use the Run As Other User option to activate a campaign as a

different user, in order to avoid accidentally removing contacts from a campaign.

@Example: Jane has both the "lllinois" and "New York" security labels assigned to
her. She has set up a campaign with various contacts that have at least one of
these labels applied to them. At some point after Jane's campaign has been
activated, someone on her team is tasked with making a few tweaks to the
campaign. Her teammate has been assigned the "lllinois" security label, but not the
"New York" label. Activating the campaign as themselves would automatically

remove all contacts with the "New York" label.



Activate Campaign
{ Campaign Activation Start Time
»

(@) Start Now

—

() Start Later:

0 Campaign Activation End Time

101672016 ke

Campaign duration set for 3 months [

Campaign Reporting will associate with this campaign from 1/4/2016 to 101682017
(12 months after the completion date).

a Campaign Activation User

—

() Run as Me

sl @) RUN as Other: v

(This selection has defaulted to the previous user)

conce |

Instead, John makes a request to his administrator to reactivate the campaign. The
administrator reviews the campaign, activates it, selects the Run as Other option,

and runs the campaign as Jane.

To run a campaign as a different user:



1. Navigate to Orchestration , then click Campaigns.

2. Open an existing campaign.

3. Click Deactivate if the campaign is active.
4. Edit the program as needed, then click Save.

5. Click Activate.

6. Select the Run as Other option, then select a user from the adjacent drop-down list. The default

selection will be the previous user to create, edit, or activate this campaign.

Gmportant: If you don't see this prompt, your security group does not have the required

action permissions.

7. Click Activate.

The campaign will run as the selected user.

CTip: Use the campaign audit to see the user(s) who previously activated a

campaign.



Campaign approvals

Campaign approvals facilitate the verification of content (emails, landing pages, and so

on) prior to activating a campaign.

®MNote: This feature is included in the Standard and Enterprise trims. For more

information, contact your account representative or log in to My Oracle Support

(https://support.oracle.com) and create a service request.

It is important to validate the content of the emails, landing pages and other content that
is included in a campaign. Campaign approvals can help you with this type of content
verification before a campaign is activated. If you do not have this add-on, campaigns can
be activated by the owner (creator) of the campaign or anyone with the necessary

permissions. See Activating multi-step campaigns for more information.

With campaign approvals, Oracle Eloqua administrators have the ability to customize the
stages in the approval workflow. They can also select which users are authorized to
approve the content that is being reviewed. After all campaign stages (steps) have been

approved, the campaign can be activated.

At a high level, the campaign approval process occurs as follows:

1. Create a standard workflow for approvals that can be used for all future campaigns. You need
to specify which users are authorized as approvers at each stage. Learn more about configuring

the campaign approval workflow.

2. Tomanage the approvals feature you must be a member of a security group that has access to

approvals. Learn more about enabling campaign approvals for groups.


https://support.oracle.com/

3. You can configure the approvals feature to allow certain groups or users to activate campaigns
without going through the approvals process. Learn more about granting campaign activation

permission.

4. When a campaign is ready to be approved, you can send a campaign approval request and

check the status of the approval.
5. Reviewers have the option to either approve or reject the campaign.

6. After the campaign is approved, it can be activated. Learn more about activating a campaign.

®MNote: The approvals workflow is not available for simple email and A/B test

campaigns.

Configuring the campaign approvals workflow

The campaign approvals workflow is a set of stages that a campaign must pass through
prior to activation. It is a global workflow for campaigns in your Oracle Eloqua instance.

You can not create separate workflows for individual campaigns.

®Note: The approvals workflow is not available for simple email and A/B test

campaigns.

To configure the campaign approvals workflow:



Click Settings ﬂ'.

Click Approvals in the Users and Security area.

The Approvals dialog box opens.

Create the necessary review stages for your approval process:

o ClickAdd ¥

. The Add Review screen opens.
b. Type the name of the stage into the Name field.

c. (Optional) Type a brief, meaningful description of the stage into the Description field.

@B(ample: The first step in your approvals process might be a review of the content in your

email and landing page. The description only appears when editing the stage. It is not shown

in the list of steps when viewing the approval process.

d. Type the name of a person that you want to set as an approver for this stage into the Reviewers field.
When the correct name appears, click the full name to add them as an approver. You can only select

individual users from your Oracle Eloqua instance.

G‘mportant: When an approver is entered correctly, their name is displayed in the field with an
X next to it. Click the X next to the name to remove them from the list of approvers.

Repeat as needed until you have the desired number of approvers for this stage.

e. Click Save to save the approval stage. The window closes and the Campaign Approvals Workflow

dialog box appears.



Repeat these substeps until you have the desired number of review stages. While there is no

enforced limit of steps, it is recommended to keep the number of stages to a reasonable level.
4. Make any appropriate adjustments to your approval stages:
¢ To reorder stages in your workflow: Click and hold a stage, then drag-and-drop it to the desired
position.
* To edit a stage : Click Edit 4 to the right of the stage. The Edit Review dialog box opens, where
you can rename, change the description, or modify the names of the reviewers for this stage.

¢ To delete a stage: Click the X icon to the right of the stage. A confirmation dialog box opens. Click OK

to confirm the deletion.

Your approvals workflow is set for your Oracle Eloqua instance.

®Note: You cannot add, remove, or modify approval stages while any campaign
remains in "Awaiting Approval" stage. However, you may add, remove (retaining at
least one reviewer), or update approvers for existing stages. To change the stages
themselves, all pending approvals must first be completed in your Oracle Eloqua

instance.

Enabling campaign approvals for groups

Before a user can approve a campaign they must be a member of a group that has the

appropriate approval permissions.

To enable campaign approvals for a group:



1. Click Settings ol
2. Click Users in the Users and Security area.

3. Click the Groups tab on the left panel.

Back to Settings Users
\JCelStated | QUsers. 3 UserDefaitsandsetings - 3 ContactSearty - (53 Dashboards - i Reportng ~ 3 Sl Sign.On |
B .
== e

Com

cent tems S
foy e ey
e 9 | |=—=

UserName  + 3 Search

2 venAl 3 VewReent 3 Crateew

User Search: Found 0 record(s) Page0of0 « < > 3

4. Locate the security group that requires approvals access. You have three options to achieve
this:

a. Expand the All Groups drop-down, then click the + symbol next to the Groups folder to navigate into

that folder.
A9 GetStarted | @ Users - § User Defauits and
T
Quick Search 5 Search
—
uy Recent tems =]
| Groups. )
B @ - Crouws
P - Actve Users- Sales
P~ Example ser Growp
ﬁ + APlUsers.
P+ Basic Users - Narketing
P, ~ CopyofBasic Users - Warketing
ﬁ ~ Copy ofEveryone
a + Customer Administrator
(£ - Engage Users
B - everyone
ﬁ + Executive Users
5 ~ Sample User Group

b. Expand the My Recent Items drop-down to access a list of recently created or modified security

groups available to you.

©2025 Oracle Corporation. All rights reserved 124 of 167



\JGetStates | Usersv ) User Defaultsand

Ploase ket Beow «
uckseusn g sean
o
uy Recen tems — O

@ - Exanpie ser Groun
D~ Sample user Group

c. Type the first few letters of the group into the Quick Search field, then press Enter.

~ Backto Seftings Users

3 Getstated | 8 Users~ 8 User DefauitsandSettings + ) Contact Seaurity ~  [&| Dashboards ~ ] Reporting + ) Single SignOn ~

Please Select Below «

Security Group Search

Growliens - Warkeing () Seach

D vewal (@ vewrent ) Gestenen

Security Group Search: Found 3 record(s) Fddd &« ¢ 2 »
B Group Name ¢ Createasy ¢ Created Date

P, - Advanced Users - Marketing 1192014 122128 P

5P} + Basic Users - Marketing 111972014 1221:28 P

£, ~ Copy of Basic Users - Marketing Nico Cheong 812412015 4:07:21 PM

5. Click the group name to open the security group profile on the right panel.

Slote: Alternatively, you can click the drop-down arrow next to a user profile, then click

Security Group Details.
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A7 Get Started 2 users~ 2 User Defaults z
Please Select Below
Quick Search  Marketing EP Search

sers Groups
My Recent ltems

)
All Groups @
B - Groups
’ ﬂ" + Active Users - Sales
ﬂ;'_ » Example User Group
Ef': - Advanced Users - Marketing
ﬂ'-'. - APl Users
ﬂ" - BasicUsers - Marketing
ﬂ" - Copy of Basic Users - Marketing
ﬂ'-'. - Copy of Everyone
g’ » Customer Administrator
Ef'. - Engage Users
ﬂ" - EvEryone
ﬂ" - Executive Users

ﬂ". [+ [sample User Group
|ﬂ" Security Group Details

% Edit Group Settings
& Visitor Motifications
5 Users in Group

L. Copy Security Group

|7 Move To Folder

6. Click Interface Access.



Security Group Overview

Name

Prospect Profiler User
Acronym

EPPU

View Users in Group

Licensing
Select which products users will have access fo.

Interface Access
Select which screens or feature areas users can navigate to.

Action Permissions
Select what users can do within specific inferfaces or feafure areas.

Asset Creation
Select which asset types users can creafs.

Default Asset Permissions
Select the default permissions applied when a user creates an assef.

Business Unit Membership
Select which Business Units users will be members of.

7. Click Edit to edit the settings for your group.

Sample User

Security Group Overview | Interface Access

Select which screens or feature areas users can navigate to. If a user does not have access fo a particular interface,
it will be completely hidden. For example, unchecking "Email” will hide the entire Email area from users in this
Security Group. The hierarchy below follows the hierarchy of how you navigate Elogua fo allow for easy configuration.
[ Ean |

Mo Interfaces have been selected

| Edit |

8. Scroll down to Settings, then click Setup to expand it.



a [1%8 Assets
[ % component Library
O Emais
L0 Forms
[0 2 anding Pages
« 188 campaigns
Om Campaigns
« 00" contacts
EE Accounts
LI» contacts
[ & custom Objacts
0O ¥ pata Took
[ @ Lead Scoring
[ prospects
[ %% segments
[ % shared Library
« 1@ customer Central
[ Contact status
[} My Account
s [ sight
= Insight
« L7 Revenue
LI Revenue Architect
[0 Ravenue Insight
a [0 settings -fe—
& AppCloud Developer
[J 8§ pata canvas
[ ® operations
B4 profie
« O0= satup A—
L& administration
8 pssets
O Database
& General
0§ websice

9. Click Assets to expand it, then select the Approvals check box.

a [0 = getup
- ] & Administration
s [ B8 Assets

_ Approvals <4

. Campaigns
__ Email Batch Control
. Email Defaults
. Email Groups & Subscriptions
. External Activities
. Master Exclude
. Redirect Links
. Response Rules

O0O000000F

10. Click Save.

The security group has been granted approval permissions.



Setting campaign activation permissions for new
campaigns

Campaigns can only be activated with the appropriate permissions. If the campaign
approvals feature is enabled, you must request approval before you can activate the

campaign.

To grant campaign activation permissions to a user or user group:

1 Click Settings .

2. Click Users in the Users and Security area.

3. Click the Groups tab on the left panel.

Backto Settings Users

& users - @ UserDefaultsand Settings ~ &) Contact Security v [53) Dashboards +  Jf) Reporting + & Single Sign-On +

% Got startea

e User Search

2 seach

2 VewAl 3 VewRecent § Crestelew

User Search: Found 0 record(s) Pageloft ¢ ¢ 3 3

4. Locate the user group you want to modify. You have three options to achieve this:

a. Expand the All Users drop-down, then click the + symbol next to a folder in order to navigate into that

folder.



Yoeseres | G Users e 3 UserDefautsand

pm—— &
QuickSearch ﬁswm
iy Recent s )
[at Groups. 0
5B - Gows

(P, ~ Active Users - Sales.

~ Example User Group.

~ Advanced Users - Marketing
v APlUsers
~ Basic Users - Marketing
~ Copy of Basic Users - Marketing
~ Copy of Everyone
+ Customer Administrator
- Engage Users
< Everyone

~ Executive Users

Bhbhhbhbhobb

b. Expand the My Recent Items drop-down to access a list of recently created or accessed user profiles

available to you.

\JGetStates | Usersv ) User Defaultsand

Please Select Belovi «
oueksearsn D searen

My Recent tems —p )
@+ Exampe User Group
D« sompievser
@ - Asvanced
@+ costomer adminstator

@ - eenone

v rows o

c. Type the first few letters of a user profile into the Quick Search field, then press Enter.

© Backto Settings Users

3 Getstated | 8 Users~ 8 User DefauitsandSettings + ) Contact Seaurity ~  [&| Dashboards ~ ] Reporting + ) Single SignOn ~
Please Select Below «
——

rout

Security Group Search

Grouplone « Mosing g} Seach

D vewal (@ vewrent ) Gestenen

Security Group Search: Found 3 record(s) Fddd &« ¢ 2 »
B Group Name ¢ Createasy ¢ Created Date

P, - Advanced Users - Marketing 1192014 122128 P

5P} + Basic Users - Marketing 111972014 1221:28 P

£, ~ Copy of Basic Users - Marketing Nico Cheong 812412015 4:07:21 PM

5. Click the group name to open the security group profile on the right panel.

Slote: Alternatively, you can click the drop-down arrow next to a group name, then click

Security Group Details.
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% cet Started 2 users~ 1 User Defaults z
Flease Select Below
Cuick Search  Marketing EP Search

sers Groups
My Recent ltems

)
All Groups @
BE - Groups
f ﬂ" + Active Users - Sales
ﬂ;'_ » Example User Group
Ef': - Advanced Users - Marketing
ﬂ'-'. - APl Users
ﬂ" - BasicUsers - Marketing
ﬂ" - Copy of Basic Users - Marketing
ﬂ'-'. - Copy of Everyone
g’ » Customer Administrator
Ef'. - Engage Users
ﬂ" - EvEryone
ﬂ" - Executive Users

ﬂ". [+ [sample User Group
|ﬂ" Security Group Details

% Edit Group Settings
& Visitor Motifications
5 Users in Group

L. Copy Security Group

|7 Move To Folder

6. Click Default Asset Permissions.



Security Group Overview

Name
Sample User
Acronym
EFPU

View Users in Group

Licensing
Select which products users will have access fo.

Interface Access
Select which screens or feafure areas users can navigate fo.

Action Permissions
Select what users can do within specific inferfaces or feafure areas.

Asset Creation
Select which asset fypes users can create.

Default Asset Permissions ]

Select the default permissions applied when a user creates an asset.

Business Unit Membership
Select which Business Units users will be members of.

7. Click Edit.

Sample User

Security Group Overview /| Default Asset Permissions

Select the default permissions applied when a user creates an asset. Default asset
permissions can only be applied fo assets that can be created by users in this Security
Group. Click here to configure the assets that can be created by users in this Security Group.

8. Onthe Campaigns tab, select the Activate check box for the security group or individual user

who needs be able to activate campaigns.



Security Group Overview / Default Asset Permissions

Select the default permissions appiied when a user creates an assel. Defaulf asset permissions can only be applied to assets that can
be created by users in this Security Group. Click here to configure the assets that can be created by users In this Security Group.

Isaac Steele |l Ada |
[view [Edit | Detete | security | Activate ||

Campaigns | Asset Creator v v v v v
Company Active Users - Sales Delete
Filters o - - - -
Contact Advanced Users - Marketing ! ! ! - ! Delete
Filters

I Basic Users - Markefing v Delete
Contact - - - - -

Groups Customer Administrator v v v v v Delete
Content

Sections

* If Activate is not selected, the user or group does not have the activation permission. If the campaign

approvals feature is in use, the user can still activate a campaign, but must first go through the

approvals process.

If Activate is selected, the user or group can activate the campaign regardless of whether or not the

campaign approvals feature is in use.

If the user or security group is not listed, type the name of the user or security group into the search

field, then click Add.

Security Group Overview

Select the default permissions applied when a user creates an assel. Default asse
be created by users in this Security Group. Click here to configure the assets that

| Isaac Steele || Add | f—




* Click Delete in the row of a user or security group to remove them from the list.

View Edit Delete Security Activate
Asgset Creator 7 ) 7 7 s
Active Users - Sales ) Delete
Advanced Users - Marketing v 7 v v Delete
Basic Users - Marketing ) Delete
Customer Administrator v ) ) v v Delete

Isaac.Steele — v 7 7 —

9. Click Save when you are finished.

Campaign activation permissions have been granted to the specified groups or individual

users.

Requesting campaign approval

Request reviews for your campaigns once your administrator has configured the

campaign approvals workflow

To request campaign approval:

1. Navigate to Orchestration , then click Campaigns.

2. Open an existing campaign, or create a new one.

5. ClickActions ” , then click Approvals.



4. Click the field below each stage to open a drop-down list of names.

Sote: Only reviewers who were added when you configured the stage will appear on

this list. In the example below, the stages Content Review and Branding Compliance

have been created and configured.

Add reviewers to this Approval process

Content Review

Branding Compliance

5. Specify the appropriate reviewer for each stage by typing and clicking the appropriate user
name. After the reviewer is added successfully, their name appears in the field with an X next to

it.

Slote: If you need to remove the name from the field, click the X next to the name.

6. Click Save after adding a reviewers to each stage.

7. Click Request Approval when you are ready to send out the approvals request.

An email is sent to the approvers requesting that they review the content assigned to

them. The sender of the email is shown as Eloqua Notifier.

The following information is included in the approval request email:



* The name of the person requesting approval.
* The stage in the approval process for which approval is being requested.
* The name of the campaign.

* The name of the segment for the first step in the approval process.

* [fitis a segment that is being reviewed for approval, the total number of contacts included in

that segment.

ORACLE Eloqua

Dear APPROVER,
REQUESTER has requested your approval:

Campaign

Campaign Object 1024
Approval Stage APPROVAL STAGE
Segment SEGMENT_NAME
Total Contacts 1234

View Campaign

When the approval is in progress, the status button of your campaign changes to the

name of the current step in the workflow.



B@xample: In the following image, the campaign is at the Content Review stage:

CONTENT REVIEW

Test

While the campaign approval is in progress, the reviewers will either approve or reject the

campaign stages.

* [f all stages are approved: The Approvals button in the top-right corner of the canvas changes to

Activate, and the campaign can now be activated.

» If a stage is rejected: The approvals process stops and the campaign reverts back to Draft

status. The reason for rejection is captured on the history tab along with the reviewer's

comments:

Stage Reviewer

Content Review Andrew
Stivelman

Branding Richard
Compliance Marzura

Date

Tuesday, March 04, 2014
11:19 AM

Tuesday, March 04, 2014
11:43 AM

Comment Status

Contentis acceptable and meets all Approved
requirements. Approving.

Does not follow approved branding. Please Rejected
update.

®Note: While a campaign approval is in progress, the campaign can still be edited.

However, after the campaign is edited, the Approve and Reject buttons next to a

stage are no longer visible, and the approvals process must be re-initiated from the

beginning.

While a campaign approval is in progress, you can check the approval status at any time.



Checking the approval status of campaigns

After you request campaign approval, you can check the status and view the stages and
reviewer comments. At any time, you (or any Oracle Eloqua user who is listed as an

approver in your instance) can see an overview of all approval steps awaiting action.

MNote: You cannot make any changes to the approval process (steps, approvers,
and so on) while the campaign (or any other campaign) is active; you must first

deactivate the campaign in order to make changes.

To check the approval status of a campaign:

1. Click the Approvals tab in the main My Eloqua dashboard.

Current campaigns pending approval and their status are displayed under Approvals,

while approval history and any responses from reviewers are displayed under History.

Approving or rejecting campaign stages

When your approval is needed for a campaign, you receive an email requesting your
participation. You can review the campaign and preview the assets on the campaign
canvas, you can then decide to either approve or reject the stage. If you reject a stage,
the campaign returns to the draft status. If you approve the stage, it continues forward in

the approvals workflow.



®Note: In order to prevent all users from being able to approve or reject a stage in
the approvals workflow, you can approve or reject a stage (step) in the process if

you have customer administrator rights and are the assigned user for the approval.

To approve or reject a campaign stage:

1. Click View Campaign in the approval request email to open the content for approval.

Sote: If you are not currently logged in to Oracle Eloqua when you click View
Campaign, you will be directed to the Oracle Eloqua login screen. Once logged in you
will need to manually open the campaign: navigate to Campaigns > Open an Existing

Campaign then search for the campaign and click Choose.

2. Right-click an asset on the campaign canvas, then click Preview. A preview window opens

where you can search for contacts.

3. Find a contact, then click the Preview button at the bottom of the window. A preview is

generated allowing you to view the asset as it will appear to that contact.

4. (Optional) Click the tabs on the top of the screen to preview what the user will see if they are

using a desktop computer, a tablet, or a mobile device.

5. Click Add Contact to preview the asset for another contact, or click Cancel to return to the

campaign canvas.

6. Click Actions > Approvals when you are finished reviewing the campaign.



7. Click either Reject or Approve to provide your decision.

A confirmation dialog box opens. Type a reason for your decision, then click Confirm.

The results of your decision are as follows:

* Approve: An email is sent to the person(s) who requested your approval. The person is

informed of your decision and provided with any comments that you made.

EN Elogua MNotifier <support@elogua.com»> -
Approved - Approval Request for Midwest Meet and Greet

'E‘ If there are problems with how this message is displayed, click here to view it in a web browser,

ORACLE | qua

Dear Christine,
Christine Cacciacarro has approved your request:
Campaign

Campaign
Midwest Meet and Greet

Approval Stage
Content Review

Segment
llinois & Indiana

Total Contacts
0

Comment
Content is acceptable and meets all requirements. Approving.

View Campaign

The Status tab is updated to show that approval has been granted via a green check mark. The
approvals workflow continues and the reviewer(s) responsible for the next step is notified that

their approval is required.

* Reject: An email is sent to the person(s) who requested your approval. The person is informed

of your decision and provided with any comments that you made.



EN Elogua Notifier <support@eloqua.com= -
Rejected - Approval Request for Midwest Meet and Greet

'E' If there are problems with how this message is displayed, click here to view it in a web browser,

ORACLE Elogua

Dear Christine,
0 Christine Cacciacarro has rejected your request:
Campaign

Campaign
Midwest Meet and Greet

Approval Stage
Content Review

Segment
lllingis & Indiana

Total Contacts
0

Comment
The location specified in the initial email is inaccurate. Please review.

View Campaign

The approvals process stops and the campaign reverts to Draft status. The reviewer's reason

for rejecting the campaign at this stage is displayed on the history tab.

In steps that have more than one reviewer, the step is considered either approved or
rejected after the first person submits his or her approval or rejection. In other words, all
approvers in a step are not required to give their responses in order for the process to

proceed to the next step.



Campaign activation security

Campaigns can be assigned a security permission called Activation, which allows
customer administrators to determine if a user can activate, view, or edit a campaign. For
example, you may want to grant a low level user permissions to create and set up a

campaign, but not have the authority to activate it.

Asset Permissions

Specify users or security groups and what level of access they will have to this asset

UseriGroup View Edit Delete Set Security Activate
4L Active Users - Sales (] O ] O
4 Advanced Users - Marketing 4 D
4 BasicUsers - Marketing |:| D D \:‘
& |saac Steele
& FrankOcean |:| D \:‘
& Customer Administrator

+ e



Mobile campaign manager

Eloqua's Mobile Campaign Manager is a mobile site designed for iOS and Android
devices that allows marketers to activate, deactivate, and monitor their campaigns
directly from their mobile devices. The mobile campaign manager provides quick insight
into the status of your campaigns, and on-the-go flexibility. Marketers can also schedule

and unschedule simple email campaigns using the mobile campaign manager.
To use the mobile campaign manager, it must be installed by a customer administrator.

Once installed, mobile campaign manager can be accessed by navigating to the

following URL:

* https://login.eloqua.com/apps/salesTools/cm


https://login.eloqua.com/apps/salesTools/cm

Walkthrough

O Recent Campaigns

Docs Example Simple SCHEDLLED
Docs Example 2

TJ_TEST

Webinar Campaign Demo

The central screen of the mobile campaign manager lists your recently-viewed

campaigns, and visually indicates their status, either draft, scheduled, or active. The



navigation bar at the top of the screen includes the Oracle E logo, which you can use

to return to the Recently Viewed screen at any time, a magnifying glass icon B ihat

opens the search bar, and a menu icon from which you can log out of the application.

Tapping on a campaign either in the Recent Campaigns screen or from the search results

shows the campaign info screen.

Campaigns in a draft state have the option to activate the campaign, and in the case of

simple email campaigns, to schedule it.



STATUS

WebEx Event Registered Decision

Start Sat Mov 15 2014 10:34:00
GMT-0500

Sun Feb 152015 10:34:00
GMT-0500

Activate

Scheduled campaigns include a button to deactivate the campaign and prevent it from

proceeding.



Active campaigns show the campaign information and also include a deactivation button
S0 you can deactivate the campaign. For simple email campaigns, there are also
campaign statistics, like the number of emails sent, opened, clickthroughs and

conversions.



STATUS

Docs Example Simple

Start Friday, October 24, 2014
10:00:00 AM EDT

Saturday, January 24, 2015
10:00:00 AM EST

EMAILS

Sample Email - Docs
Subject: Hello, World!

21 O

SENT OPENS




Installing mobile campaign manager

MNote: You must add the app to your catalog and install it before you can start

using the service.

(mportant: Because deleting or deactivating the installer user account will impact
installed apps, we recommend installing apps using a user account that is not tied

to a specific person. The user account must have customer administrator rights.

To install mobile campaign manager:

1. Follow the URL provided:

https://cloudmarketplace.oracle.com/marketplace/app/AppMobileCampaignManager

2. Click Get App.

3. Log in with your Eloqua credentials, if required.

4. Click Accept and Install to add the app to your Apps list.
5. Click Save. (This app does not require any configuration.)

6. Click Accept or switch users.

The app is now installed and can be viewed in your Apps list (Settings &> Apps, under

the Platform Extensions section). Select an app to view a description, reinstall, or

uninstall it. You can also check its status and dependencies.


https://cloudmarketplace.oracle.com/marketplace/app/AppMobileCampaignManager
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Apps

Warning: Selecting the Reinstall option ¥ foran app will force you to go through

the entire installation process again. The app will be unavailable for all users during

the reinstall.

Once installed, mobile campaign manager can be accessed by navigating to the

following URL.:

* https://login.eloqua.com/apps/salesTools/cm

Scheduling a campaign with the mobile campaign manager

With the mobile campaign manager, you can schedule a right from your mobile device.

You must have already created the campaign within Eloqua before you can edit and

activate it with the Mobile Campaign Manager.

To schedule a campaign in the mobile campaign manager:

1. Open the mobile campaign manager on your mobile device. To access the mobile campaign

manager, navigate to https://login.eloqua.com/apps/salesTools/cm/.

2. Open the campaign that you wish to edit:

¢ Select a recently-viewed campaign from the list, or

¢ Search for a specific campaign by tapping the magnifying glass icon and searching by the campaign


https://login.eloqua.com/apps/salesTools/cm
https://login.eloqua.com/apps/salesTools/cm

name.

Example
P Cancel

Docs Example 2

Docs Example Simple

Draft Campaign Example - Sim
ple

Scheduled Campaign Example ... "o

Validation Errors Example




The campaign status screen will open, showing the campaign status, the start and end dates,

and any related assets.

3. Select Edit. You will be prompted to select when you would like the email campaign to launch.

STATUS
WebEx Event Registered Decision

Campaign Activation Start Time

Select when you would like this
campaign to activate

| ® Send right now

© Schedule for a later time

|

Cancel




4. Choose to either Send right now, or Schedule for a later time. This will overwrite the
scheduling information you provided when you created the campaign in Eloqua. If you choose
to schedule at a later time, you will need to provide the date and time that the campaign should

go live.

5. Select Activate.

The campaign status screen refreshes to show that the campaign is now scheduled.
When the campaign is activated, the campaign status screen indicates that the campaign

is active, and shows some simple campaign reporting metrics.

®MNote: Reporting metrics are only available for simple email campaigns.

To unschedule a campaign in the mobile campaign manager:

1. Open the mobile campaign manager on your mobile device. To access the mobile campaign

manager, navigate to https://login.eloqua.com/apps/salesTools/cm/.

2. Open the campaign that you wish to edit:

¢ Select a recently-viewed campaign from the list, or

» Search for a specific campaign by tapping the magnifying glass icon and searching by the campaign


https://login.eloqua.com/apps/salesTools/cm

name.

Example
P Cancel

Docs Example 2

Docs Example Simple

Draft Campaign Example - Sim
ple

Scheduled Campaign Example ... "o

Validation Errors Example




The campaign status screen will open, showing the campaign status, the start and end dates,

and any related assets.

3. Select Edit. You will be prompted to confirm that you wish to unschedule the campaign.

STATUS SCHEDULED

Docs Example Simple

Start Scheduled for Tuesday,
December 23, 2014 11:48:00
AM EST

Do you wish to Unschedule this
Campaign Tuesday, December
23,2014 11:48:00 AM EST ?

|

Cancel

-\‘.—".II.I]EI..-I.. (R L=am e SR LT




4. Select Confirm.

The campaign status screen refreshes to show that the campaign is in a draft state. You

can click Activate to reschedule it.



External assets and activities

External assets are non-Eloqua activities performed by your contacts or prospects.
These assets can be imported for use in Oracle Eloqua campaign reporting. In addition,

data associated with these activities can be passed to your CRM systems.

External activities can be displayed in Eloqua Profiler. This feature provides a 360-
degree view of a contact's activities across all Oracle Eloqua functions, including email

sends, web visits, and external activities.

External activities can also be used as part of your CRM integration allowing you to track

responses to all campaign activities and export them to your CRM.

Oracle Marketing AppCloud apps can also generate external activities. For example, an
app that is added to the campaign canvas might use external assets and activities for use

in campaign reporting.

You can include external activities in your campaign reporting or use the Campaign
External Activity or the Account Activity subject areas to report on external activity

performance.

Learn more by watching the video

Concepts and definitions

Before beginning the process of importing non-Eloqua assets and activities into Oracle
Eloqua, it is important that you have an understanding of the terms related to this

functionality, as follows:

* External Asset Type: The top-level classification for something that your contacts are

performing, for example, a Tradeshow.


https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
CampaignDetail.htm
CampaignDetail.htm
AccountEngagementOverview.htm
https://www.youtube.com/playlist?list=PLw7GyH-Hj8cMbDF08cqhZ5tNTJKPZkbkI

* External Asset Name: The first sub-category for the asset type. For example, ifitis a

Tradeshow asset type, then the asset name could be the name of the Tradeshow.

* External Activity Type: The specific activity that the contact or prospect performed for this
specific external asset. For example, if it is a tradeshow event, then activities could include

"Registered", "Canceled", "Completed", and so on.

* Campaign ID: The ID of the campaign in Oracle Eloqua. This is reflected in the URL for each
campaign. For example, https://secure.p01.eloqua.com/Main.aspx#campaigns&id=XXX,

where XXX is the campaign ID.
* Date: The date of the activity that is being captured. The format is MM/DD/YYYY.

* Email Address: The email address of the contact or prospect performing this activity.

Tradeshow
EXTERMNAL ASSET TYPE

Eloqua Experience
EXTERNAL ASSET NAME

Open World

EXTERNAL ASSET NAME

|

Registered
EXTERNALACTIVITY TYPE

Canceled
EXTERNAL ACTIVITY TYPE

Completed
EXTERNALACTIVITY TYPE

Email
= CampaignID
Date

For a pre-existing campaign, when you upload external activities into your Oracle Eloqua
instance, the upload file must include all of the information above. If you are creating the

activity while creating a campaign, you do not need to include the campaign ID.



Creating external asset types and activity types

Create external asset types an activity types for the external activities that you want to
track. Later, you can upload the external activities for contacts. See Uploading external

activities

®Note: You should update your response rules as you create new external

activities.

To create external activities:

1. Click Settingsﬂ' and then click External Activities in the Database Setup section.

2. Create the contact field:

* |nthe classic Ul, click Add + .

¢ Inthe Redwood experience, click Add External Asset.

3. Provide a name for the asset type. For example, Tradeshow.

4. Add the activity types that contacts will perform for this asset type. For example, Registered or

Attended.



* |nthe Classic Ul, click Add +

R b b g

refnd | ey Asser " pe

in the right pane and provide the activity name in the new row.

External Assets and Activibes

Extemnal Asset Type Tradeshow

D Please click the box to select an image

Image lcon

Extemnal Activity

Cancelled Registration
Registerad

Viewed a Demo
Attended

:

Save

* |nthe Redwood experience, click Add Activity and provide the activity name in the new row.

Activity details

Activity Name ¢

“ Untitled External Activity

Registered

5. When you're done adding activity types, save your asset type.

Uploading external activities

‘ Add Activity ‘

MNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the U.


EloquaRedwoodExperience.htm

You can import external activities using an import file. For a more automated solution,

consider using the External activity app.

Before you begin:

* Create your upload file (.txt, .csv, .xls, .xlIsx). It must contain the following columns:

* External Asset Type
e External Activity

» External Asset Name
* Contact Email Address

e Campaign ID (always include if known)

The Campaign ID can be found in each campaign's URL. For example,
https://secure.p01.eloqua.com/Main.aspx#campaigns&id=XXX, where XXX is the
campaign ID. If you initiate your upload from the campaign canvas, you don't need to

provide the campaign ID.

* Date (MM/DD/YYYY format)

®ote: To ensure the external activity generates a campaign response, the date must be
between the reporting start date of the campaign and the current day's date. Uploading an

external activity with a date before the campaign's reporting start date or after the current date
will result in the activity successfully being added to the contact record, however will not create

a campaign response for that activity.

* Additional contact fields can be included as well like first and last name, and so on.


ExternalActivityApp.htm
https://secure.eloqua.com/Main.aspx#campaigns&id=

Rjote: With Salesforce integration, the Salesforce Campaign ID must be mapped to the Last

SFDC Campaign ID contact field in Oracle Eloqua, unless a list upload is preformed directly to

a campaign to create external activities.

* Separate the fields in the upload file using a comma (,), pipe (|), or semi-colon (;).

* The first row of the file must be column headings. Oracle Eloqua will attempt to map the

headings to existing Oracle Eloqua fields.

* If you are adding or updating contacts, make sure that you can map the data in your upload file
to contact fields in Oracle Eloqua. Use similar naming conventions in your upload file to make

this mapping easier.

MNote: If a contact does not exist in your database, Oracle Eloqua will automatically

create the contact.

To upload an external activity:

1. Navigate to Orchestration , then click Campaigns.

2. Choose the upload action:

* Inthe classic Ul, click Upload External Activities.

* Inthe Redwood experience, click Actions > Upload External Activities.



@'ip: To upload activities directly to a campaign, first open the campaign, then click

Actions > Upload External Activities.

3. Complete the information about the upload. You'll want to be sure to click the correct type of

upload from the Import Purpose drop-down list.
4. Verify the contents of the file on the Review tab and click Next Step.

5. Complete the field mapping. You need to map both the external activity fields and the contact
fields included in your upload file. Make sure that you select when you want the fields to update
using the Update Type drop-down list. For example, update the field if it is blank or not blank.
Using Set to default will use the default configuration for each field. In the classic Ul, if a
specific field should be updated differently than the rest, double-click the field and configure the

update type for that specific field.
6. Complete the final step of the wizard. You can add the contacts into a shared list.

7. Click Finish.

The activities are uploaded. If a contact does not already exist in your Oracle Eloqua
database, Oracle Eloqua will create a contact. Uploading an external activity will also
trigger Oracle Eloqua to check when the activity was imported and re-score contacts

associated with the imported data based on any active lead scoring models.

Resolving issues with an import

If you configured the import to send a confirmation email, the email details results of your

import, and it provides links to any failed operations for troubleshooting purposes.



From: Elogua Activity Upload Notification System <support@eiogua.com:>

Ta: Andrew Stivelman
[
Subject: API Data Import Asset/Activity/Contact completed

ELOQUA

& API Data Import Asset/Activity/Contact completed

51472014 4:07:68 PM BM4/2014 £:08:21 PM 22 seconds

Activity Upload details:

Client OrienTest

Name Data Import - 1400098044581

Data upload Source General (.csv)

Upload Purpose APIDatalmportAss stActivityGontact

Execution details:

File: Tradeshow External Activity

Import File Total Number of Raws: §

2
° Upload.csv
Validate
@ Email
Address
, Validate o
% e Invalid Asset Type: 0
° Validate Invalid Campaign Data: ©
Activity Invalid Activity [
© Greate Created New Assets: 1
Assets
N New Contacts: 2
ntity Type:  Canta
@ Greate S Edited Contacts 3
Activities Entity Field: Email Address

Created New Activities: §

If there were any failures, you must resolve them before the import can complete. To
resolve a failed import, you must update the original source file with the applicable fixes,

and upload the file again.

In the following example, there were five invalid entries for Campaign Data that must be
resolved to complete the import. As a result of this failure, no data was imported. To view

more details about the failure, you click the link provided.

ELOQUA
T .

-

b ey e s

Execution details:
] Import File File: Tradeshouw Bxtemal Activity Total Number of Rows: 5
Upload.csv
Validate
@ Email
Address
Validate .
3 0
% st Type Invalid Asset Type: 0
-~ validate ——————>» Invalid Gampaign Data: 5
< Activity Invalid Activity 0
" Create
) i Created New Assets: 0
AU — New Contacts, [}
niity Type: Contac
& Create s Edited Contacts: 0




In this example, the import failed because the campaign specified was invalid.

Upload Rejected Rows

Rejected Reason: invalid Campaigns
Total Records: 5

Rowr Number Email

elcampaignid  External Asset Type  External Activity External Asset Name  Date First Name Last Name
1 andrew.stivelman@oracle.com 30839 Tradeshow Registered Eloqua Experience 2013 11/13/2013 Andrew  Stiveiman
F john cle.com 30839 Tradeshow Registered ience 2013 11/13/2013 John Stefic

3 aliso 30838 Tradeshow Cancelled Registration Eloqua E: 2013 M/1372013 Alison Burnett
4 alice 30839 Tradeshow Attended Eloqua E; 2013 M/1372013 Alice Johnson
5 fred fintstone@bedrock biz 30839 Tradeshow Registered Eloqua Experience 2013 11/13/2013 Fred Flintstone
Total Records: §

Viewing external activities on contact records

®MNote: We're updating our help center to reflect the new Redwood experience.

During the transition, some content reflects the previous version of the Ul.

To view external activity on a contact record:

Navigate to Audience ﬁ, then click Contacts.

—

N

Locate your contact. Learn more about searching for contacts.

w

Double-click the contact to open the Edit Contact menu.

s

Click the Activity Log tab.

If the external asset and external activities related to this contact have been correctly

uploaded, then you can see that data in the Activity Log.


EloquaRedwoodExperience.htm
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=SearchingContacts

Summary Field Details Preferences ©Campaigns | Activity Log | Scoring Linked Records

All Activities - 8/4/2016 B ot 6/8/2017 ]
Activity Type Activity Details Date and Time
Email Open Enterprise Systemn Management 4MB/2017 332 PM
'ExternaIActi\.rity Registered Eloqua Experience 2017 Tradeshow 4M1B/2017 332 PM
-Email Clickthrough Enterprise System Management 4162017 3:32 PM
Email Open Enterprise System Management 4MB2017 3.32 PM

Editing external assets and activities

You can edit an existing external asset and its activities.

Good to know:

* If you change an asset type's activities, past activity values don't change. If, for example, you
change the name of an activity from "Signed Up" to "Registered," previous instances are listed
as "Signed Up." Future instances are listed as "Registered." Gather data under current as well

as future names if you want to capture historical as well as current values.

* [f you rename an external activity type, any response rules associated to that type will need to

be updated.

To edit an external asset and its activities:

1. Click Settingsﬂ' and then click External Activities in the Database Setup section.

2. Search for and select the asset type you want to update:

¢ Inthe classic Ul, select the asset type and make your changes in the right panel.

In the Redwood experience, select the asset type. Click the actions menu and then click Edit.



3. Edit the list of external activities as needed:

* To delete an activity, in the classic Ul, click the activity, then click Delete _ . In the Redwood

]

experience, click .
¢ Torename an activity, double-click it, then type in a new name.

* Toadd an activity to the list, in the classic UI, click Add + , then rename the activity that appears. In

the Redwood experience, click Add Activity and provide the activity name.

4. Save your changes.
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